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Welcome

Welcome to Reckon Accounts. Whether you’ve been running your business for years or are just starting out, having
an organised, efficient way to manage your business can save you time, money, and a lot of frustration.

Use this Startup Guide to get up and running as fast as possible. In this guide, you'll learn about:

How to install Reckon Accounts and set up your company file
Important Reckon Accounts terms and concepts

How to get around in Reckon Accounts

Where to look for help when you have questions

How to perform common tasks

Note: Since this guide covers multiple editions of Reckon Accounts, the name “Reckon Accounts” is used to refer to any of these
editions. When information in this guide applies to a specific edition of Reckon Accounts, the specific edition name will be used.

How to use this guide
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Verify that your computer meets Reckon Accounts system requirements
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Convert data from other applications

Create and set up your company file

Learn how to get help if you have questions

Learn about essential Reckon Accounts tasks
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Begin with the Reckon Accounts Installation and Upgrade Guide

In order to get the most from this Startup Guide, you should first install or upgrade your Reckon Accounts software
so that you can follow along and explore the topics described.

Foryour convenience, the Reckon Accounts hardware and software requirements, and information about installing Reckon
Accounts for new users and for multiple users is provided in this chapter.

However, if you are upgrading from an earlier version, you need to ensure that your company data file is properly upgraded
for use with Reckon Accounts. Itis especially important that you carefully read and follow the instructions provided in the
Reckon Accounts Installation and Upgrade Guide.

The Reckon Accounts Installation and Upgrade Guide provides important information that you need to know BEFORE
you install or upgrade your software. You'll save time, find answers to your questions, and avoid potential problems if you
follow this step-by-step guide.

The Reckon Accounts Installation and Upgrade Guide is included with every purchase of Reckon Accounts. In
addition, you'll find the latest version of the Guide, including any last-minute changes or updates, on the Reckon
Accounts web site:

(https://www.reckon.com/au/downloads-guides/).
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System requirements

2.0 GHZ Intel Pentium IV (or equivalent)

1GB of RAM required for Windows 7. Windows 8 & 10 require 1GB for 32Bit & 2GB for 64Bit.
1GB RAM for Windows Server 2008/2012/2016/2019"

Windows 7/8/10 operating system

1 GB of disk space (additional space required for company files)

Microsoft .NET Framework Common Language Runtime 2.0 & 3.5 (provided on Reckon Accounts Installation DVD.
requires an additional 150 MB.)

(NZ Only) Microsoft .NET 4.0 for the Reckon NZ Payroll E-File Checker (provided on Reckon Accounts Installation
DVD. requires an additional 150 MB.)

Requires 9 MB for Pro Timer

At least 256-colour SVGA video

1024x768 pixel screen resolution

DVD drive or internet connection for downloads

All online features and services require Internet access with at least a 56 Kbps modem (ADSL or Cable Modem
recommended)

“Windows Small Business Server 2008 requires 4GB RAM. Windows Small Business Server 2003 is not supported.



Integration/compatibility requirements

*  Microsoft® Word, Excel and Outlook integration requires Microsoft Word, Excel and Outlook 2010, 2013, 2016 or
20109.

e Compatible with Reckon Point of Sale Professional 2019 or Reckon Point of Sale Lite 2019

“You may experience an issue when creating PDF files from Reckon Accounts if you are using Adobe Acrobat Reader 9.0. Please
search PDF in our Knowledge Browser at http://kb.reckon.com.au/ for more information.

Firewall and antivirus software compatibility

If you use firewall or anti-virus software, it may be necessary to adjust settings in these applications to ensure
the best possible performance with Reckon Accounts. Refer to your firewall or antivirus product documentation for
further information.

Using firewall software on a network

If firewall software is running while you install Reckon Accounts, you may be asked if you want to allow Reckon
Accounts components to have access to the network. For Reckon Accounts to operate properly (especially in a
multi-user environment) these components (QBDBMgrN.exe, QBW32.exe, QBLaunch.exe, and QBUpdate.exe) must be
allowed to access the network.

Different firewall software applications use different terminology when prompting you. Be sure to choose an option
that does not block connections to Reckon Accounts components. Also, some firewall and antivirus software can
affect Reckon Accounts performance. If you experience performance issues you think are related to your firewall
software, refer to the firewall documentation or contact your firewall supplier for assistance.
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Multi-user installation requirements

Multi-user mode is optimised for Microsoft Windows Server 2008, Windows Server 2012, Windows Server 2016 and
Windows Server 2019 operating systems, and for Windows 7/8/10%**.

Terminal Services are supported for Reckon Accounts Premier and Enterprise.

**Not all versions of Windows 7/8/10 are supported. Support is provided for Windows 7/8/10 Pro and above.
Windows Server 2003 is no longer supported.
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About multi-user installation

Reckon Accounts lets you give multiple users access to Reckon Accounts company files on a network at the same
time.

To enable other users to work in the company file, the company file must be stored on a computer on your network,
and you need to complete some additional installation and setup steps on the computer where the company file is
stored. Refer to “Installing and setting up Reckon Accounts for a multi-user environment” on page 18.

In a multi-user environment, Reckon Accounts (or the Reckon Accounts company File Server) should be installed on
the computer on which the company file is stored. Each user must have a Reckon Accounts license and must:

e |nstall the same version. For example, all users must have Reckon Accounts.
* Have read/write access and create/delete rights to the directory where the company file is stored.
* Have a valid License Key and Product Key.

Note: The company file can be accessed at the same time by up to 5 users with Reckon Accounts Premier, and up to 30 users with
Reckon Accounts Enterprise.

Note: The number of users who can access the company file at the same time is not necessarily equal to the number of licenses
you purchase. For example, using Reckon Accounts Premier, if you purchase licenses for 5 users, and then purchase an additional
license for the sixth person in your office, only 5 of the 6 users can access the file at the same time.

For setup on a simple network with no dedicated server

To run Reckon Accounts in a network environment with no dedicated server, Windows 7, Windows 8 or Windows 10
installed.

In a network environment with no dedicated server, each computer has its own copy of Reckon Accounts installed;
however, the Reckon Accounts company file is located on only one computer, which must be turned on and available
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on the network. Networks set up for hosting files do not use a dedicated file server, so a single, dedicated computer
is not required to share files. Thus, all the networked computers have the option to share their resources.

For example, you might run your small business by using Reckon Accounts on two computers—yours and one that’s
used by an employee. In this case, you still need to set up a simple network to share your company file. Otherwise,
you’ll need to make a backup of your company file to move it or email it between the two computers.

For setup on a network with dedicated file server

To run Reckon Accounts in a network environment with a dedicated file server, you must have Windows Server 2008,
Windows Server 2012, Windows Server 2016, Windows Server 2019, Windows 7, Windows 8 or Windows 10.

Networks with a dedicated file server have at least one computer (the file server) dedicated to sharing files, printers,
or other resources. You should store your company file on the server.

11
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Installing Reckon Accounts

Reckon Accounts provides three different installation options. Refer to the table below to choose the installation
option that’s right for you and then follow the appropriate instructions on the following pages.

Note: If you work in a multi-user environment, you might need to choose different installation options on each computer.

Choosing the correct Reckon Accounts installation option

Installation Option

Install Reckon Accounts
Only

When to Use

If you are a single user (the only person in your company running Reckon
Accounts) and not accessing the company file from another computer on a
network.

If you run Reckon Accounts on a network and access the company file from
another computer. (No other Reckon Accounts users will access a company

file from this computer.)

Refer to

Page 14
(new users)

Page 15
(upgraders)
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Install Reckon Accounts

or

If you are working in a multi-user environment on a network, and this
computer stores (hosts) the company file that other users will access from

their computers.

with the Company File Page 19
Server e If you are running Reckon Accounts in a home office, where you run Reckon

Accounts on two computers (perhaps a desktop and a laptop), but this

computer stores (hosts) the company file that will be accessed by both

computers.

* If you are working in a multi-user environment on a network, and this
Install Reckon Accounts ! .
. computer stores the company file that other Reckon Accounts users will

Company File Server Page 20

Only

access, but no one will actually run Reckon Accounts on this computer. (This
computer simply acts as a dedicated file server.)

Note: Based on the installation type, each computer is configured to either “host” company files or not. If you need to change this
setting after installation, refer to the in-product Help. Search for “hosting” to find related topics.

13
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Install Reckon Accounts Only, for new users

To install and start Reckon Accounts:

A
B

T— & M m

Shut down all running programs, including anti-virus programs.

Insert the Reckon Accounts DVD in your computer’s DVD drive.

Note: If the Installation Wizard does not start automatically, click Start in the taskbar, and then click Run. Type D:\setup.exe
(where “D” is the DVD drive letter). Click OK.

In the Welcome to Reckon Accounts Installation window, click Begin.

Read the Reckon Accounts licence agreement, click | accept the terms in the licence agreement, and then click
Next.

Enter your Installation Key Code (IKC), then click Next.
Select Install Reckon Accounts Only, then click Install Now.
Follow the onscreen instructions.

To start Reckon Accounts, double-click the Reckon Accounts icon on the desktop or click the Windows Start
button and then click Reckon Accounts from the Programs group.

Creating your company file

The first time you use Reckon Accounts, the Setup Interview window is displayed. The Setup Interview asks you
questions about your business and then uses the information you provide to create your company file. For detailed
information about creating your company file and setting up your company in Reckon Accounts, see “Setting Up Your
Company in Reckon Accounts” on page 27.



Install Reckon Accounts Only, for existing users
(upgraders)

If you own a previous version of Reckon Accounts and are upgrading to
Reckon Accounts, you must first install the new program and then update
your company file.

Important: For your convenience, a simplified set of installation instructions
for upgraders is provided here. However, you'll save time, find answers to
your questions, and avoid potential problems if you follow the instructions
provided in the Reckon Accounts Installation and Upgrade Guide. To learn
more about the Installation and Upgrade Guide, see page 6.

To install Reckon Accounts:

A Shut down all running programs, including antivirus programs.

B

Insert the Reckon Accounts DVD in your computer’s DVD drive.

Note: If the Installation Wizard does not start automatically, click Start in
the taskbar and then click Run. Type D:\setup.exe (where “D” is the DVD
drive letter). Click OK.

In the Welcome to Reckon Accounts Installation window, click
Begin.

Read the Reckon Accounts license agreement, click | accept the
terms in the license agreement, and then click Next.

Enter your Installation Key Code (IKC), then click Next.

Installing Reckon Accounts

Did You Know?

Back up your previous accounting system

If you have an existing business, make sure that
you've backed up your financial records from
your previous accounting system. In Australia,
the ATO requires you to keep this information for
seven years. You should also keep any software
and hardware that your previous accounting
system used, or have printouts of all the
information and accounting reports.

Troubleshoot error messages

If you receive an error message during
installation, and rebooting your system does
not resolve the problem, you can search for the
error message on the Reckon Accounts support
site at

www.reckon.com.

15



F  Select Install ReckonAccounts Only, then click Install Now.

G Follow the onscreen instructions.

H After installation, the File Management Tool might instruct you to move your company files or to perform some
additional installation modifications. Follow the onscreen instructions.

Note: We recommend that you keep your old version installed. You may need it to perform operations on your old company file.

| To start Reckon Accounts, double-click the ReckonAccounts icon on the desktop or click the Windows Start
button and then click Reckon Accounts from the Programs group.

Updating your company file

This section describes how to update a company file created in a previous version. Before you can update your
company data, you must install the new version of Reckon Accounts as described above.

Back up your data before opening it in a new version of Reckon Accounts. You can back up to your hard drive or to a
backup disk.

Caution: After you update an existing company file to Reckon Accounts, do not delete your original company file. You may
need it to generate reports on transactions before this date.

To update your file:

Note: If you are updating a company file from an earlier version, you will need to first upgrade your company file with 2007/08. If
you need assistance, refer to the Reckon Accounts Installation and Upgrade Guide, or contact Reckon Technical Support.

A In Reckon Accounts, open your existing company data file.

B When prompted to update your file, enter YES and click OK.

16
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C Click Next and follow the onscreen instructions.

*  When prompted to back up your company file, choose the directory on your hard drive or the disk drive where
you want to store your backup file and click OK.

Failing to back up your file might result in lost data if you encounter a problem during the update process. Do
not overwrite existing backups with this upgrade backup.

e If prompted to move or rename your company file, we recommend that you allow the utility to move your
company file from the Program Files folder to C:\Users\Public\Public Documents\Intuit\
QuickBooks\Company Files.

Note: The Windows Program Files folder is no longer a recommended location for storing company files.

D When Reckon Accounts indicates that it is ready to upgrade your company file, click Finish. Depending on the size
of your company file, the upgrade process may take up to an hour.

Note: Due to changes and improvements in the Reckon Accounts data file format, the size of your company file might
significantly increase after you update it.

If an update problem occurs

If you attempted to upgrade your file and the update failed, you must perform steps in your earlier version to fix the
problem. If you removed your earlier version, reinstall it to a new directory. Do not install the older version in the
directory where you installed Reckon Accounts.

To fix a failed file update:
A Start the earlier version.

B Open the earlier version of your company file. If necessary, you can restore your company backup using the
earlier version. Go to the File menu, click Open or Restore Company, and then follow the onscreen instructions.

17



C Go to the Window menu and click Close All.

D Go to the File menu, click Utilities, and then click Rebuild Data.

Caution: The Rebuild Data utility forces you to create another backup. Use a new DVD or USB drive. Do not overwrite any
existing backups.

E After the rebuild is complete (which may take a long time depending on the size of your company file), exit the
earlier version.

F  Start Reckon Accounts.

G Go to the File menu and click Open or Restore Company.

H Select the appropriate directory and file name of the company data you just rebuilt and click OK. The update
should take place normally. If you still experience update problems, refer to the Reckon Accounts Installation
and Upgrade Guide, or contact Reckon Technical Support.

Installing and setting up Reckon Accounts for a multi-user environment

There are two ways to set up Reckon Accounts to be used in a multi-user environment, which will allow more than
one user to access your Reckon Accounts company file at the same time.

* The Simple Network installation enables users on a network to share files between their computers directly
(there is not dedicated file server).

* The Server installation enables you to place your Reckon Accounts company file on a dedicated file server where
all users can access the file.

For all installations, you must then follow the “Completing Multi-user setup” instructions on page 21.

18
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Simple Network Installation: For multi-user environments in which users will access the company file(s) on this
computer from another computer on the network. The user on this computer will also run Reckon Accounts. (In this
type of network, computers are connected to each other, but there is no machine configured as a dedicated file
server; instead, each computer on the network can be configured to share files.)

A Make sure your computers are properly networked. Refer to your operating system’s documentation for more
information.

B Shut down all running programs, including antivirus programs.
C Insert the Reckon Accounts DVD in your computer’s DVD drive.

Note: If the Installation Wizard does not start automatically, click Start in the taskbar, then click Run. Type D:\setup.exe
(where “D” is the DVD drive letter). Click OK.

D In the Welcome to Reckon Accounts Installation window, click Begin.

E Read the Reckon Accounts licence agreement, click | accept the terms in the licence agreement, and then click
Next.

F  Enter your Installation Key Code (IKC), then click Next.

G Select Install Reckon Accounts with the Company File Server, then click Install Now.

H Follow the onscreen instructions.

After installation, you may be asked to move your company files to another directory, or to perform some
additional installation modifications. You can also scan your computer for company files that need to be shared.
Follow the onscreen instructions.

New users should proceed to setting up the company file as described in “Setting up Your Company in Reckon
Accounts” on page 27. Upgraders should update their existing company file by following the detailed instructions
in the Installation and Upgrade Guide.

19
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For each additional user who will use Reckon Accounts on the network, follow steps 1 through 8 above, except in
step 7, choose Install Reckon Accounts Only instead.

Dedicated File Server Installation: For multi-user environments using a dedicated file server to store the Reckon
Accounts company file(s). This computer stores the company file, but no one runs Reckon Accounts on this
computer.

A Make sure your computers are properly networked. Refer to your operating system's documentation for more
information.

B Shut down all running programs, including antivirus programs.

C Insert the Reckon Accounts DVD in your server’'s DVD drive.

Note: If the Installation Wizard does not start automatically, click Start in the taskbar, then click Run. Type D:\setup.exe
(where “D” is the DVD drive letter). Click OK.

D In the Welcome to Reckon Accounts Installation window, click Begin.

E Read the Reckon Accounts license agreement, click | accept the terms in the license agreement, and then click
Next.

F  Enter your Installation Key Code (IKC), then click Next.
G Select Install Reckon Accounts Company File Server Only, then click Install Now.

H Follow the onscreen instructions.



| At the end of the server installation, you must launch the Reckon
Accounts Database Server Manager from the System Tray or from
All Programs and scan the server for company files.

J For each additional user who will use Reckon Accounts on the
network, follow the instructions above except in Step 7, choose
Install Reckon Accounts Only instead.

Hosting Multi-user access

The installation option you choose configures the hosting settings
for each computer. If you need to change the hosting settings after
installation, refer to the multi-user setup topics in the in-product Help.

Note: If you cannot install Reckon Accounts or the Reckon Accounts Server on
the computer where your company file is located, you will need to choose a
computer to act as the “host.” On that computer, open each company file in multi-
user mode to configure the alternate hosting settings. For detailed steps, see the
in-product Help topics for using the “Alternate Setup” for multi-user mode.

Completing Multi-user setup

After you install Reckon Accounts on each computer on your network
and set up your company file, you need to perform these additional
tasks:

e Set up user names and passwords for each user. You will need to
assign one user to be the Administrator who defines all other users’
access. Refer to the in-product Help for instructions on setting up

Installing Reckon Accounts

Did You Know?

Installing from a server

If your Reckon Accounts DVD is mounted on a
server or a shared DVD drive, you can install
from the DVD, but you cannot install from the
DVD to a remote computer.

Choosing where to store your company file in a
multi-user environment

Choose a location for your company file where
all the computers that need to use Reckon
Accounts can access the file. For a simple
network system with no dedicated file server,
you might want to put the company file on the
computer of the person who most frequently
uses Reckon Accounts. This enables that
person to have the fastest access to the
company file.

Improving performance in multi-user mode

To improve Reckon Accounts performance in
multi-user mode, consider these tips:

e Store company files on the fastest or most
powerful computer, preferably a dedicated file
server.

* Run large reports outside of business hours.

* Refresh reports only when you're ready to use
or print them.

* Avoid keeping unnecessary Reckon Accounts
windows or other applications open.

21



user names and passwords.

¢ Share the folder that contains your Reckon Accounts company file across your network. You can press F2 while in
Reckon Accounts to locate your company file. See your operating system’s documentation to learn more about
sharing folders.

e Activate each copy of Reckon Accounts, as described in “Activating Reckon Accounts” on page 25.
* Turn on multi-user mode in each copy of Reckon Accounts you have installed on your network.

A Go to the File menu and click Switch to Multi-user Mode.

B Click Yes.

Note: Based on the installation type, each computer is configured to either “host” company files or not. If you need to change this
setting after installation, refer to the in-product Help. Search for “hosting” to find related topics.

You may need to expand the number of people who work on Reckon Accounts in the future. Each additional user
must have his or her own license.

Why are passwords important?

Passwords limit access to your company file. To open a password-protected file, each person must enter his or

her user name and a unique, case-sensitive password. Defining users and passwords helps prevent unauthorised
people from accessing your company’s confidential data.

We strongly recommend that you password-protect the Admin user. Otherwise, anyone who can access the company

file will have full access rights. By defining users and their access rights, you not only control who can open your
company file, but also what data they can view and tasks they can perform.

22
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Troubleshooting installation problems

What should | do if | have trouble installing Reckon Accounts?

A
B
C

D

Verify that your system meets the minimum system requirements, listed on page 7.

Restart your computer.

Close all open programs, including anti-virus programs. Go to the Windows Task Manager (Task List), click the
Applications tab, and close all open programs.

Try installing Reckon Accounts again.

If you need further installation assistance, contact Reckon Technical Support. You can also visit the Reckon Accounts
support website at https://www.reckon.com/au/support.

What should I do if | can’t find my Registration Number?

Reckon Accounts no longer uses registration numbers. The only number you’ll need is your Installation Key Code
(IKC), found on a sticker with your Reckon Accounts DVD or by clicking My License Information from the Help menu.

Why doesn't my old administrator password work after | upgrade?

From 2004 release and later, case-sensitive passwords are supported. If you believe you are entering the correct
password, but are still getting the message “The password you typed is incorrect.” try the following:

Attempt to log on by entering the login name of Admin and then click OK without typing a password.
Enter your password with Caps Lock or Num Lock turned on or off.

Enter password variations, using mixed upper- and lower-case characters.

Enter the password with a space before or after the actual password.
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* Type the password in a text editor to confirm that your keyboard is functioning properly.

* Restore a pre-update backup of your file that does not have the case-sensitive password. When you restore this
file, you can set your new administrator password at the end of the update process.

If you are still unable to access your file, contact Reckon Technical Support for assistance.

Can | install different versions of Reckon Accounts on the same computer?

Yes. You can install multiple versions of Reckon Accounts on the same computer.

Can | revert to an earlier version?

Yes. Uninstall the version of Reckon Accounts that you don’t want and then reinstall the earlier version. Remember
that you will not be able to open company files that you have updated to Reckon Accounts in earlier versions. You
can, however, restore your pre-update backup if you choose to go back to a prior version.

Can | install Reckon Accounts on more than one computer?

No. The Reckon Accounts license agreement allows Reckon Accounts to be installed on only one computer. If you
wish to install Reckon Accounts on a second computer, you must purchase an additional licensed copy.

Note: Reckon Accounts Premier and Enterprise come with multiple licences, so they can be installed on multiple computers.



What should | do if | get an error message during
installation?

If you receive an error message during installation and rebooting your
system does not resolve the problem, go to the Reckon Accounts
website (https://www.reckon.com/au/support) and search the
Knowledge Base for solutions to common errors, or contact Reckon
Technical Support.

What should | do if | get an error message when updating
my company file?

If you receive an error message when updating your company file from
a earlier version, refer to the information in “If an update problem
occurs” on page 17. You can also visit the Reckon website (https://
www.reckon.com/au/support) and search the Knowledge Base for
information about error messages, or contact Reckon Technical
Support.

Installing Reckon Accounts

Did You Know?

Record your password in a safe place

Be sure to write down and save your
administrator password in a secure place.
Passwords not only protect your company data,
but are also required to access your company
file if you upgrade your version.

Passwords are case sensitive

Keep in mind that passwords are case sensitive.
When adding or editing a user password, check
the Caps Lock and Num Lock keys. If you
mistype the password, you will not be able to
access the company data.

Product Information window

The Product Information window lists information
about your software, including the number of
entries you have in your lists, the size of your
company file, which version of Reckon Accounts
you are running, and the location of your
company file. To open the Product Information
window, press F2 on your keyboard.
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Activating Reckon Accounts

You can use Reckon Accounts up to 6 times without activating. After 6 sessions, you must activate Reckon
Accounts.

Go to the File menu and click Activate Reckon Accounts. You can also activate by phone at 1 300 650 0641, available
9:00 am to 5:00 pm AEST Monday through Friday.

Note: If you choose to install Reckon Accounts on a second computer, or if you need to move your installation to another computer,
you will need to re-activate Reckon Accounts.

Getting the latest updates to Reckon Accounts

From time to time, Reckon provides updates to Reckon Accounts that can be downloaded from the Internet. These
updates might include new features, services, maintenance fixes, or new Help information.

Updates are available at the Reckon Accounts website (www.reckon.com). Click Support menu, then click Support,
and then navigate to the Downloads section.

Converting data from other applications

If you are converting financial data from another application (such as Microsoft Excel), follow the instructions below.
Excel

Detailed instructions about importing Excel® (.xls) and comma separated values (.csv) data into your Reckon
Accounts company file are provided in the Reckon Accounts in-product Help. Importing data from Excel and .csv files
is not difficult, but does require you to prepare the file properly.
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To view the file preparation and conversion instructions:

A Start Reckon Accounts. Go to the Help menu and click Help.
B Click the Search tab in the Help window.

C Click in the Search field and enter importing Excel data.
D Click About importing data from an Excel or CSV file.

Note: If your Excel file is ready to be converted, you can convert it. Go to the File menu, click Utilities, click Import, and then click
Excel Files.

Setting Up Your Company in Reckon Accounts

The first thing you need to do in Reckon Accounts is create a company file for your business. Setting up your
company file properly is the most important thing you can do to have Reckon Accounts help you manage your
business efficiently.

The setup process is easy with the Setup Interview and should take you about 15 minutes to complete. Then,
depending on the complexity of your business, completing your company setup can take anywhere from a few
minutes to a few hours. The amount of time varies based on how much detail you add about your accounts,
customers, suppliers, employees, products, and services, as well as the number of historical transactions you want
to enter.

When you set up your company file, Reckon Accounts will prompt you for details about your company. Before you
begin the setup process, gather the information shown in the Getting Started Checklist. Some of this information
you’ll need for the Setup Interview; other information you will need as you begin to use Reckon Accounts.
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Creating your company file

After you have gathered the company information listed in the Getting Started Checklist, you can set up your
business using the Reckon Accounts Setup Interview. (Not all of the information in the checklist is required for the
Setup Interview; however, you will need this information as you use Reckon Accounts to run your business.) The
Setup Interview walks you through the setup procedure and helps you tailor Reckon Accounts for your business.

Getting Started Checklist

Company name
and address

You'll need both the trading and legal names for your company. The legal company name is the
name you use when filing taxes for your business. The trading company name is the name that you
want to appear on invoices, statements, reports, etc. (This is your “Doing Business As” name.)

Start date

Reckon Accounts uses a start date as the point at which you begin entering your business
transactions. You must enter all historical transactions between your start date and today to ensure
complete accounting records for your business.

Many business owners base their accounting records on their financial year, so that they can see
transactions for the entire year. If this is not important to you, you can choose a different starting
point, such as today or the first of the month, quarter, or year.

Australian Business
Number (ABN)

The Australian Business Number (ABN) is a single identifier for all business dealings with the tax
office and for dealings with other government departments and agencies. In Reckon Accounts, your
ABN will serve as your Tax ID.
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Getting Started Checklist

Installing Reckon Accounts

Bank statements,
credit card
accounts, and
outstanding
cheques

You'll need the most recent bank statement for one of your bank accounts with a closing date that’s
before your start date. The closing balance on this statement will be your opening balance for the
bank account you create in Reckon Accounts, and then you’ll enter all the open transactions, and
all the new transactions from the start date forward. Eventually, you will need to have your latest
bank statement balances and any outstanding cheques, deposits, withdrawals, or charges for all

of the accounts you want to set up and manage in Reckon Accounts, including credit cards, bank
accounts, lines of credit, and loans.

Assets and Liabilities

You will need the balance of each loan your business owes (liabilities) such as a bank loan, hire
purchase, or director’s loan; or is owed (assets). If you have stock, you need to know its value as of
your start date.

If you are operating payroll, you need to know how much PAYG tax you owe to the ATO as of your

PAYG Liability ——
If you are using Payroll, you should gather the following information from your employees: company
Payroll information; compensation, benefits, and miscellaneous additions and deductions; tax information;
employee information; year-to-date history; and liability payment information.
. Eventually, you will need to enter detailed information about your customers, suppliers, and
Optional . .
information employees, as well as the products and services you sell, the products that you hold in stock, and

any additional assets.

To create your company file:

A Start Reckon Accounts by double-clicking the Reckon Accounts icon on the desktop or by clicking the Windows
Start button and then clicking Reckon Accounts from the Programs group.

B Click Create a new company file, or go to the File menu and click New Company.
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C The Welcome screen for the Setup Interview opens. Click Start Interview.

Note: We recommend that you do not skip the interview process. The more information you enter with the Setup Interview, the
more accurate your company file will be when you begin to use Reckon Accounts for your business.

However, if you are an experienced Reckon Accounts user and prefer to create your company file manually, you can skip the
Setup Interview by clicking Skip Interview on the Setup Interview Welcome screen. You will be prompted to enter some basic
company information and to save the company file.

D Follow the onscreen instructions and complete the interview. Make sure you write down where you are saving
your file for future reference.

Completing your company setup

After you've created your company file, you can begin using Reckon Accounts to run your business. But before you
do, we recommend that you review the information in this section to make sure your company file is properly set up
and that your data is complete.

This section describes some additional tasks you might need to do as you begin using Reckon Accounts. Depending
on how much information you entered during the Setup Interview, some of these tasks might not apply to you.

Enter your company information

Do this task if you did not enter this information in the Setup Interview.

To enter the contact and legal information for your company, go to the Company menu and click Company
Information. To learn more about each of the fields and where the information you enter will be used in Reckon
Accounts, click the Help button.
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Review your Chart of Accounts

If you used the Setup Interview, a chart of accounts based on your type
of business was set up for you. Review the chart of accounts to be
sure it accurately reflects the accounts you need to run your business.
You can change account names and edit, delete, or add accounts as
necessary. For example, you will need to add any personal bank, credit
card, or loan accounts.

To view your Chart of Accounts, go to the Lists menu and click Chart of
Accounts.

Numbering your accounts

Some businesses prefer to organise their accounts by number. Adding
numbers can help you identify the type of accounts, thereby speeding
up your account selection on various forms. You might want to develop
and follow a consistent account naming and numbering convention. For
example:

1000-1999 - Assets

2000-2999 - Liabilities
3000-3999 - Equity

4000-4999 - Income
5000-5999 - Cost of Goods Sold
6000-6999 - Expenses
7000-7999 - Other Income

Installing Reckon Accounts

Did You Know?

Company file

The company file is the data file that Reckon
Accounts uses to store and manage all the
information and financial transactions for your
business. Reckon Accounts company files have
the extension .qbw.

Historical transactions

A list of all business transactions as of a
specific date. In Reckon Accounts, you can have
many different lists of historical transactions,
including:

* Estimates * Invoices

e Sales receipts e Customer payments
* Adjustment notes * Purchase orders

¢ Item receipts e Bills

* Payments to suppliers ¢ Credits with suppliers

e Journal entries e Payroll transactions

Emailing a company file

The Reckon Accounts portable company file
(*.gbm) is a compact version of your company
file. You can use the portable company file to
move the company file to another computer or
to email the company file to another person,
such as your accountant. To learn more about
the portable company file, refer to the in-product
Help.
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8000-8999 - Other Expense
If you want to use numbers to identify your accounts, you need to turn on this preference in Reckon Accounts, as follows.
A Go to the Edit menu and click Preferences.
In the Preferences window, click Accounting in the list on the left.
Click Company Preferences.
Select the Use account numbers checkbox.
Click OK.

m O N @

Create your customer, supplier, and items lists

To bill customers and pay your bills with Reckon Accounts, you must update your customer, supplier, and item lists
so that they accurately reflect your business. Instructions for setting up these lists are provided in Chapter 4:

e “Adding Customers” on page 69
* “Adding Suppliers” on page 72
*  “Adding ltems” on page 75

Enter historical transactions

If your start date is before today’s date, you'll need to enter past transactions from the start date to today. This
ensures that your Reckon Accounts records are completely up-to-date and your reports will be accurate.

Enter historical transactions in chronological order. For example, Reckon Accounts won’t know how to credit a
customer payment unless you’ve previously recorded the invoice to that customer. The most efficient way to enter
historical transactions is in the account register.

32



Installing Reckon Accounts

Note: Entering historical transactions is especially important if customers don’t pay you at the time they receive goods or services. If
you don’t enter historical transactions early on, it's hard to track and collect late customer payments.

Reckon recommends that you enter your transactions in this order (verify with accountant):

* |nvoices or statements you've sent out since your start date

* Purchase orders you've issued since your start date that you haven’t received in full

e Cash or cheques you've received since your start date

e Bills you've received since your start date

e Bills you've paid since your start date

* Deposits you've made to any of your accounts since your start date

* Any other cheques you’ve written (for things other than bills) since your start date

e Employee year-to-date information accrued from the beginning of the financial year through your start date

e Payroll liabilities owed at the time of your start date (for manual payroll and tracking payroll transactions only)
Note: If you don’t have time to enter all your historical transactions right away, don’t worry. You don’t need to enter all your past
transactions before you start using Reckon Accounts for new transactions. Enter new transactions as they occur. Then catch up with

historical transactions when you can. Remember, though, that your account balances will be incorrect (and your reports may be
wrong) until you enter all the past transactions.

Complete your bank account information

After you've entered your historical transactions, your account registers will contain entries reflecting bills you've
paid, cheques and payroll payments you've written, and deposits you've received. To make your account registers
complete, you must also enter these transactions:
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* Cheques orothercharges that happened before your start date but didn'tappear on statements before your start date
(i.e., didn’t clear)

e Other cheques you wrote after your start date that were not for bills or accounts payable (for example, credit card
payments)

* Deposits you made after your start date that were not customer deposits

* Deposits you made before your start date but that didn’t appear on statements before your start date
* Bank charges and fees

* Interest paid on your account

Refer to the in-product Help for step-by-step instructions on how to enter these transactions to make your account
registers accurate.

Enter any optional adjustments

After you've created your company file, you might need to make a few adjustments as of your start date. Depending
on your company, you might need to:

* Enter any tax liabilities

* Adjust the Uncategorised Income and Uncategorised Expense accounts (for accrual basis only)

e Adjust for current income and expenses if your start date is not at the beginning of the financial year
* Distribute earnings and equity before your start date

Refer to the in-product Help for step-by-step instructions on how to enter these optional adjustments. If you are
unsure whether you need to enter these optional adjustments, check with your accountant.
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Backing up your company file

The Reckon Accounts backup file is a compressed version of your
Reckon Accounts company file that contains all transactions through
the date the company backup was made. A backup file provides
insurance against accidental data loss and can be used to restore your
data. Reckon Accounts backups have a .gbb extension and cannot be
opened directly.

Reckon Accounts provides the following backup options for securing
your data:

e Standard backup
e Portable Company File

To use one of the backup options, go to the File menu and click Save
Copy or Backup.

To restore your backup, go to the File menu and click Open or Restore
Company.

To learn more about backing up your company file, refer to the in-
product Help.

Next steps

After you've installed Reckon Accounts and set up your company file as
described in this chapter, you should:

* Learn how to use Reckon Accounts and get answers to your

Installing Reckon Accounts

Did You Know?

Assets

Company assets are the things that your
company owns. Reckon Accounts distinguishes
between two types of assets:

Current assets: Assets that you are likely to
convert to cash within one year (such as the
cash you have on hand, the money in your
current and savings accounts, and the money
your customers owe you).

Fixed assets: Assets that you do not expect to
convert to cash within one year. A fixed asset is
usually something you use to run your business
(such as a truck, cash register, or computer).

Confirming your opening balance when
transferring data to Reckon Accounts

If you used an accounting program before using
Reckon Accounts and you are now transferring
data from that program to Reckon Accounts,
make sure that the opening balance for your new
bank account in Reckon Accounts is based on
your bank statement and not the bank balance
from your previous accounting software. The
balance of the bank account from your previous
accounting software will not include post-dated
transactions or transactions that the bank has
cleared.

35



questions (see Chapter 3).
e Learn how to perform basic Reckon Accounts tasks (see Chapter 4).
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Getting Around Reckon Accounts

The Reckon Accounts work area is designed to enable you to complete tasks quickly. Reckon Accounts provides

several ways for you to work; choose the method that works best for you.

The menu bar provides easy Refer to the in-product Help for The customisable icon bar

access to all Reckon Accounts
tasks, features, and reporting
functions.

detailed instructions about how
to perform tasks.

that you use most.

on the toolbar provides one-
click access to the features
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Using the Home page to move around in
Reckon Accounts

When you open a company file in Reckon Accounts, the Home page

is displayed automatically. The Reckon Accounts Home page provides
a big picture of how all your essential business tasks fit together.
Tasks are organised into logical categories (Customers, Suppliers,
Employees, Company, and Banking) with workflow arrows to help you
learn how tasks relate to each other and to help you decide what to do
next.

Note: The workflow arrows indicate a logical progression of business tasks in
Reckon Accounts. However, these arrows do not restrict you from doing tasks in a
different order, or an order that works better for your business needs.

To start a task, simply click the icon for the task you want to do. For
example, to create an invoice, click the Invoices icon.

To return to the Home page, click the Home button on the navigation
bar.

The Home page also provides a quick glance about the state of
your business. You can see your current account balances, updated
automatically as you do work in Reckon Accounts, in the Account
Balances list.

The Home page you see has been customised to display only those
tasks and features that you use, based on the questions you answer
in the Setup Interview. Functions you don’t need won't clutter your
workspace. However, if you decide to use these functions later, you

Learning Reckon Accounts

Did You Know?

Customising the desktop

You can modify the way that the Reckon
Accounts desktop behaves and looks to suit
your working style. To modify the Reckon
Accounts desktop, go to the Edit menu and click
Preferences.

Customising the icon bar

You can add, rearrange, and remove shortcuts
from the icon bar to suit your needs. To modify
the icon bar, go to the View menu and then click
the Customise Icon Bar.

Too many windows open?

If your Reckon Accounts work area becomes too
cluttered with windows that you have open, you
can close them all at once instead of closing
them one at a time. To close all open windows,
go to the Window menu and click Close All.

When you close your company file at the end of
the day, it's good practice to close all windows
that you have open. The next time you open your
company file, Reckon Accounts will open all the
windows that you had open when you closed
your company file. If you forget to close open
windows when you exit Reckon Accounts, hold
down the Alt key while opening your company
file. Reckon Accounts will open your company file
with no windows open in your work area.
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can always add them back to the Home page by clicking the Customise Reckon Accounts link in the Getting Started
section of the Home page.

Finding your data in the Reckon Accounts Centres

Reckon Accounts includes Customer, Supplier, and Employee Centres where you can view and manage all of your
customer, supplier, and employee information and transactions. You can go to one of the Reckon Accounts Centres
by clicking the appropriate button in the navigation bar (on the left side of the toolbar).

@ o e

Customer Centre Supplier Centre Employee Centre

Customer Centre

The Customer Centre lets you view and work with all your customer information. Without having to sift through
multiple screens, you can view a list of all your customers and see pertinent information for each of them. Click on
a customer’s name and you’ll immediately see all the activity you've had with them as well as their pertinent contact
information (phone number, fax number, and payment terms).

You can use the Customer Centre to find out how much money a specific customer owes you, or to view a list of all
your customers with open balances. You can also look at all your customer transactions (estimates, sales orders,
invoices, adjustment notes, refunds, etc.) across all of your customers in the Transactions list rather than having to
run separate reports.
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Easily access your customer’s Run quick reports that pertain
contact information and any to this customer.
notes on that customer.
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Supplier Centre

The Supplier Centre gives you a complete picture of where your money is going. From one screen, you can see all
your suppliers and exactly what you owe them. Simply click a supplier’s name to view your entire history with that
supplier. You no longer need to run separate reports to see exactly how much business you're doing with each
individual supplier. And, you can sort your bills by due date so you can stay on top of your finances.

If you need to talk to a supplier, click their name and you’ll see all their contact information. If a supplier calls you to
follow up on a late payment, you can quickly look up the bill and see when you paid it and what the cheque number
was.

Employee Centre

From the Employee Centre, you can see exactly what you're paying each employee. Simply click an employee’s name
to view that person’s payroll history. And if you need to get in touch with an employee, their contact information is
right in front of you.

Payroll Centre

The Payroll Centre is the hub for managing all payroll activities. The Payroll Centre reminds you of important payroll
dates so you pay your employees, pay your payroll liabilities, and file forms on time.

To view the Payroll Centre, go to the Employees menu and click Payroll Centre.

Displaying multiple windows or one window

Reckon Accounts is preset to show multiple windows at a time. By doing so, you can easily navigate between tasks
as well as compare data in multiple windows. When you open a window, it opens to a preset size and location. You
can resize and move each window as you see fit.
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Depending on how you size or arrange the windows, some windows might not be visible. Use the Window menu to
view a list of the open windows. Simply click the window name in the list to bring it to the front.

Alternatively, you can open the Open Window List to have the list of open windows always visible on the left side of the
Reckon Accounts application window. If you prefer to view only one window at a time, go to the View menu and click One
Window.

Adding icons to the icon bar

For quick access to the areas of Reckon Accounts you use most, you can customise the icon bar by adding many of
the features and reports that you use most frequently.

View Lists Accountant Company Custor You can add, rearrange, or remove
shortcuts from the icon bar in the

Customise Icon Bar window.

v Open Window List

v Navigation Bar
v Icon Bar To add a shortcut to Accounts

Customise Icon Bar,., ——— window, open the window and then
go to the View menu and click
the Add to Icon Bar option.

Add “Chart of Accounts”to Icon Bar...

Note: Some Reckon Accounts windows cannot be added to the icon bar.

43



Getting Answers to Your Questions

Reckon Accounts provides a variety of tools and resources to help you find answers to questions you might have
when using Reckon Accounts. Available resources include:

e In-product Help

e Additional self-help tools

* Assisted support

* Reckon Professional Partners

Using in-product Help

Reckon Accounts in-product Help provides background information and instructions for doing Reckon Accounts
tasks. You can access the Help content and features in several ways.

To use in-product Help, go to the Help menu and click Reckon Accounts Help.
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Use the Index tab to find Help topics for a
specific QuickBooks term or concept. Enter Click the Printer icon to
a keyword in the field or scroll through the list. print a topic.

Hidk Back Pint
Index | Search About depositing payments @
When you receive payments from customers, you can
. Search Results either deposit each payment directly into a QuickBooks
Enter a question in the ek 3 question &.g. how do | reset my check?" bank account or you can group payments together to be
Search tab and click Ask to moved to that account later. You can also choose the
N Tmeking o depost — Eilask method you prefer for depositing payments.
seatrch tfhe tehntlrefHelp i ' ’,W,:w m,ﬂ,k%,;ls How do I choose a deposit method? @
szz j/':ntor € information B S s When to use undeposited funds @
¥ . 10 topics displayed. A ||| How do 1 set undeposited funds as the default account? &

How do I deposit payments in Undeposited Funds? @
Finding a deposit

Getting cash back from a deposit Ealale)

= Depositing money from a refund (not customer
Entering deposts that are not related)
customer-related

£ = Setting up payment iterns
= Using payment items on invoices

Deposit detail report

Depositing loan money
Activating Direct Deposit
Setting up Direct Deposit

About depost schedules and
frequencies

Printing & deposit summary only

€3

Getting step-by-step instructions

Throughout Reckon Accounts you’'ll find windows with a How Do | button. Clicking this button provides quick access
to instructions for tasks associated with the window.
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Add new accounts and subaccounts »
_ Remove an account from the list
Enable a credit card for online access Change information for existing accounts
Change account information

Rename an account

Transfer funds between accounts
Rearrange this list of accounts
What if I mix business and personal funds?
Use online account access

Viewing Help for a window you have open

If you are unsure how to use a particular Reckon Accounts window, press the F1 key on your keyboard to get help.

(You can also click the Help button to view these Help topics.) These Help topics provide answers to questions such
as:

* What can | use this form for?

* What does this button do?

* What kind of information is displayed in this column?
* What happens when | select this option?
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Learning Reckon Accounts

Using Help Search and Index to find information

Reckon Accounts in-product Help is quite extensive. Use the Help Search and Index to find answers to your questions
quickly.

To find information using Search:
* Type your question in the Ask field in the title bar of most Reckon Accounts windows and click Ask; or

* (o to the Help menu, click Reckon Accounts Help, and then click the Search tab. Enter your question in the
Search field and click Ask.

Tip: Using Search Effectively Entering questions of 3-10 words produces better search results than simple
keywords. For example, instead of typing “invoices,” enter How do I create invoices? in the Ask field.

Make your questions as specific as possible. They should not get too long or contain too many keywords. For
example, “How do | add customers?” will return better results than “How do | add new customers and suppliers?”

If you get no search results, check the spelling in your question. Reckon Accounts knows about some common
misspellings, but other misspellings will not be caught. Do not use abbreviations. Try different keywords.

If you can’t find your answer in the topics returned by search, click the Show all results checkbox to see more
topics.

To find information using the Index:
A Go to the Help menu, click Reckon Accounts Help, and then click the Index tab.
B Enter a term in the blank field. The index will scroll and display the available entries.

C Double-click the index entry that best describes that information you want.
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Using the sample company files

Reckon Accounts includes several sample company files that you can practice with to enter pretend data, run
reports, and explore Reckon Accounts features.

To open a sample company file, go to the File menu, click Open or Restore Company, and then click a sample
company file from the list.

Additional Self-Help Tools

If you cannot find the answer you want in the in-product Help, try these other resources.

Support Resources page in Reckon Accounts

From the Support Resources page, you can:

* Learn about your assisted support options and how to contact Reckon
e Learn about and sign up for support plans

* Find a Reckon Accounts Reckon Accredited Partner

* Learn about training resources

To open the Support Resources page, go to the Help menu and click Contact Support.

Online Knowledge Browser

The online Reckon Accounts Knowledge Browser (www.reckon.com.au/support/FAQs.aspx) provides a free library of
articles for each Reckon Accounts product family. In the Knowledge Browser, you can find:

* Answers to common user questions
e Product update information
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e Useful links to product updates, support plans, customer service,
and current news articles

e Technical help for a variety of Reckon Accounts issues

Getting Assisted Support

If you cannot find the answer you want using the in-product Help or
other self-help tools, get assistance from a Reckon Accounts expert.

To learn more about free and paid Reckon Accounts Assisted Support
options and how to get help, go to the Help menu and click Contact
Support, or open a web browser and visit www.reckon.com.

Working with a Reckon Accredited Partner

From time to time, you might need advice that is very specific to your
business situation. In this case, you'll want to contact your accountant
or another specialised professional.

If you do not have an accountant or bookkeeper working for you,

you can find a Reckon Accredited Partner located near you from our
website. Reckon Accredited Partners are independent accountants,
bookkeepers, computer consultants, and trainers who work with small
businesses every day. They can offer guidance on everything from
business planning to tax advice.

To find a Reckon Accredited Partner in your area, open a web browser
and visit
www.reckon.com.au/FindAnAp.

Learning Reckon Accounts

Did You Know?

Getting help from Reckon Accounts
professionals

Want local professional help setting up or
customising your Reckon Accounts? You'll

get the most out of Reckon Accounts when a
Reckon Accredited Partner helps you customise
the software for your unique needs.

* Save time and money by getting your Reckon
Accounts setup right the first time, rather than
fixing mistakes down the road.

* Reckon Accredited Partners can help you
set up appropriate reports so you can easily
understand the health of your business

If you don’t currently work with an accounting
professional, or your accountant isn’t a Reckon
Accounts expert, you can look for a Reckon
Accredited Partner in your area who can help you
set up and customise your Reckon Accounts by
visiting www.reckon.com and clicking Partners.
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Reckon Accounts Basics

To take full advantage of Reckon Accounts, there are some important concepts you need to understand.

How Reckon Accounts lists work

Lists are one of the important building blocks that make Reckon Accounts so powerful and efficient. You use
information stored in lists to fill out most Reckon Accounts forms. For example, to create an invoice, you choose the
customer name from your Customers & Jobs list. Reckon Accounts automatically enters the customer information on
the form for you. This saves you time and prevents typing errors. You can also change the information directly on the
form as needed. Lists are easy to set up in Reckon Accounts, but do require careful planning.

Depending on the type of list you want to use, you can get to the list in one of two ways:

* Reckon Accounts Centres: Your Customers & Jobs, Suppliers, and Employees lists are available in the
Customer, Supplier, and Employee Centres, respectively. Click the appropriate Reckon Accounts Centre button on
the navigation bar to go to a Reckon Accounts Centre. Then, click the tab for your list.

e List windows: Other lists, such as the Chart of Accounts and Item list, appear in separate windows. To view one of
these lists, click the Lists menu and then click the list you want. To enter information in these lists, use the menu
button at the bottom of the list to add, edit, or delete list items. The list menu also provides access to common
features associated with the list.

The more detail you enter for each list item, the more information Reckon Accounts can use to pre-populate forms,
track financial data, and display useful reports about your business. Another advantage of lists is that common
tasks like adding list entries, editing list information, and deleting list entries are performed the same way.

The figure below illustrates how Reckon Accounts uses list information across multiple windows and tasks to simplify
data entry and to give you a complete picture of how your business is doing.



1. Use the Customer Centre to view customer data.
Click New Customer & Job to add a customer
to your list.

2% NewCustomer-. ) e rnsacions+ 5 prt ) Costumert30b e Fport..

2. Enter customer information in the
New Customer window.

cotomsnzte | Tramsacions || rhety [ Mimoces v e [Thsremn.. v G1A7I0 - 0008
T R T

6. To view a list of invoices for all your customers,
use the Transactions tab.

Learning Reckon Accounts

3. The information for the new
customer appears in the
Customers & Jobs list.

8 crete imoices
Qs Brs G - Bond - s Gk
ot Comers £

Tax Invoice

1 owe .| ovman- s

Ty ool

5. All invoices for this customer are listed in the
Transaction Details area.

) it 1
=] Jimen T
Bl

Gamacen ] Gt J (o ]

4. Pick a customer name from the list and choose
to create an invoice from the New Transactions
menu. The customer information is entered
automatically.
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Entering list information as you work

There are two basic methods you can use to enter list information in Reckon Accounts. You can enter account,
customer, supplier, product, and service information before you enter transactions in Reckon Accounts, or you can
enter this information “on the fly” as you use the product.

If you prefer to enter information as you use Reckon Accounts to perform your daily tasks, Reckon Accounts
prompts you to immediately set up any entry it does not know about. For example, if you try to create an invoice
for a customer named John Walker and you have not entered information about John Walker into Reckon Accounts,
Reckon Accounts will prompt you:

F N

CustomerJob Mot Found

"-\I Sam Stone is not in the Customer:Job list.
r

E..Eastndd J [ Set Up ] [ Cancel

Clicking Fast Add creates a new customer list entry for John Walker in the Customers & Jobs list and adds all the
information you enter about the customer on the invoice form (billing address, payment terms, taxable status).

Clicking Set Up takes you to another window where you can enter information not covered by the invoice. For
example, you could click Set Up to enter John Walker’s phone number, fax number, and credit limit.



Learning Reckon Accounts

Writing cheques versus paying bills
In Reckon Accounts, you can manage your bills and payments in two ways:

Write cheques to pay bills now. Use the Write Cheques window and assign the amounts to appropriate expense
accounts.This method is recommended when you don’t receive a bill, such as when you go to the store and write
a cheque and then you need to record that expense in Reckon Accounts. You can also use Write Cheques to pay
a bill as soon as you receive it, as long as you don’t need to track the bill.

Enter bills when you receive them and pay them later. Use the Enter Bills window to enter bills when you receive
them. Then use the Pay Bills window to pay bills when they are due. You can set up Reckon Accounts to remind
you to pay bills when they are due. Using this method, you keep your money in your business for as long as
possible. You might still use a cheque to pay the bill, but this method enables you to track how much money you
owe. And at any time, you can run reports to analyse unpaid bills for information such as which suppliers you owe
money.

Note: Do not simply write a cheque in the Write Cheques window to pay bills that you entered in the Enter Bills window or the
accounts payable registers.

The following figure illustrates the difference between writing cheques versus entering and paying bills.
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Write Cheques
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Pay Supplier

Pay tothe Order of Gallon Mabonry

No. 302
Date 14/07/2008 [
L 4 8,900.00

Gallon Masonry
189 Old Bayshore Road
Address | Svdney, NSW 2000

Print cheques or make
an online payment

Receive bill from supplier

Customer: Your Company
Address: 1234 Garcia Ave. Bil Due 13/08/2008

BILL Payment Due to Gallion Masonry

Date 14/07/2008

Mountain View, CA 94043

Amount Due 155000

Write cheques now

e paybills

o, Om e [ 8]
e

Pay Bills
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pay when due
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Reckon Accounts Workflow | Visual Overview
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Essential Tasks

Learning how to do essential Reckon Accounts tasks

The diagram to the left shows a visual overview of the essential tasks that most people use to run their company in
Reckon Accounts. This chapter describes how to perform each of these tasks and offers important usage tips.

The tasks are written assuming that you want to set up all the information for your business (for example, customer,
supplier, and account information) before you begin creating invoices, receiving payments, or paying your bills.

However, you might prefer to enter information as you need it. For example, you might create an invoice for a new
customer and use Fast Add to enter the customer information “on the fly”. Either method works fine. You choose the

method that works best for you.
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Setting Up Your Business | Preferences

Preferences: Modify Reckon Accounts for the way you work

Set personal and company

Preferences

i

preferences for each R hecounting

Reckon Accounts area. & ek
| - | [[JPressing Enter moves between fields  [_] Bring back all one time messages
| Blle ] Automatically open drop-down lists ] Turn off pop-up messages for
HY8 pecktop View when typing products and services

Click General to set % Finance Charge - [[JBeep when recording a transaction ] Show ToolTips for clipped text

¥ General

general Reckon Accounts —Q
preferences.

[[] Automatically place decimal point 0 Warn when deleting a transaction or i
ﬂ Integrated Applications unused list iterm
| PP | [[]warn when editing a transaction

& 1tems & Inventory |
=7 Jobs 8 Estimates
G online
@ Payroll & Employees
1 q& Reminders
|l Reports & Graphs

Automatically recall information
Automatically remember account or transaction information
(O Automatically recall ast transaction for this name
(® Pre-fill accounts for supplier based on past entries

Choose a group from the
preference list to set
behaviour for other
Reckon Accounts areas.

Default Date to Use for New Transactions
(O Use today's date as default (® Use the last entered date as default

Keep custom item information when changing item in transactions
@ Ask O Always (O Never
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Changing Reckon Accounts for the way you like Did You Know?
to work

Company preferences
You can _modlfy Reckon Accounts in many ways to suit the needs of Company preferences are global preferences
your business and your personal style of working. From the Reckon that affect all users of the company file. Only the
Accounts Preferences window, you can define preferences in over a Reckon Accounts Administrator can set up or
dozen different categories. fiedijcelieav S EIces
For example, you can configure general preferences such as whether My Preferences
or not Reckon Accounts prompts you before editing or deleting a You can customise your workflow by setting
transaction, or which date Reckon Accounts uses for new transactions. personal Reckon Accounts preferences, such

as using the Enter key instead of the Tab key to

Or, you can configure accounting-specific preferences such as how )
move between fields.

Reckon Accounts displays accounts and subaccounts.
To view and set preference options:
A Go to the Edit menu and click Preferences.

B In the Preferences window, change any of the general Reckon
Accounts preferences. These preferences determine how Reckon
Accounts behaves.

C To display the preferences for another area of Reckon Accounts,
click the appropriate category in the scroll list on the left. For
example, to set preferences for reporting functions, click Reports &
Graphs.

D On the My Preferences tab for the particular feature area, enter
the changes and settings you want. These settings affect only your
Reckon Accounts sessions, not those of other users.

59



E Do one of the following:

Click OK to close the Preferences window and save your changes.

Click another feature area in the scroll box to enter other preferences. Click Yes when prompted to save your
changes.

F  Click OK.
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Setting Up Your Business | Adding an Account

F N\
The Chart of Accounts list
shows the balance of each
balance sheet account for

L your business.

J

( N
Rearrange your accounts by
clicking and dragging the

Chart of Accounts

diamond to the left of an

account to a new position.
o

J

Click the Account button to
create new accounts or
perform tasks with existing
accounts.

FuChart of Accounts Type a help question | Ask | % How Do I?

Name $ | Type Balance Total |
Le-Current-Account < |Bank 7,178.06 a
+Savings $ |Bank 13,868.42
+Cash Expenditures Bank 0.00
-+ Barter Account Bank 0.00
+Accounts Receivable Accounts Receivable 76,610.00
+Tools & Equipment Other Current Asset 5,000.00
+ Employee Loans Other Current Asset 0.00
+ Inventory Asset Other Current Asset 23,102.54
+Retainage Other Current Asset 2,461.80
+ Undeposited Funds Other Current Asset 36,982.34
< Land Fixed Asset 90,000.00
+ Buildings Fixed Asset 325,000.00
o Tricks Fixed Asset 78,352.91

New Ctrl+N Fixed Asset 28,501.00

i Ctrl+E Fixed Asset 7,325.00

Edt Fixed Asset -121887.78

Delete CultD Other Asset 1,041.85

A P: | 239.
Make Account Inactive ctr:ecgil:nct:rdayab € 505 3333
Show Inactive Accounts

v Hierarchical View $ [Credit Card 25.00

Flat View $ |Credit Card 0.00

. Credit Card 5,071.02

Customise Columns... Other Current Liability 0.00

Other Current Liability 3,302.06

Import from Excel... Other Current Liability 5,353.52

Use Ctrl+U Long Term Liability 19,932.65

. P Long Term Liability cichhlcps

LRSS Long Term Liability 3,440.83

R Long Term Liability 50,162.38

el Bk Equity 403,590.82
Re-sort List Equity 19,000.00 ¥/

["Account ¥]|  Activities v | Reports ¥ |J7 Include inactive
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Type a help question V How Do I?H.E_H.EI.
IITT| AccountType  [Bank -

General | Online Bark Details |

Account Name | |

Subaccount of I = |
Optional
Description
Bank Acct. No. |
Tax-ine Mapping | <Unassigned: - | How do I choose the right tax line?

I Enter Opening Balance... ] Should I enter an opening balance?
Remind me to order cheques when I reach cheque number l:l
Order cheques I can print from Reckon Accounts Learn more

Save &Close | | Save&bew || Cancel |
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Adding an Account

When you set up your company file, Reckon Accounts sets up certain
accounts for you automatically. However, as your business grows

or changes, you might need to add new accounts to your chart of
accounts to better organise your finances. Or, you might need an
account that was not provided during setup. For example, you might
want to create expense accounts to track office supply purchases
separately from advertising costs.

To add an account:

A Go to the Lists menu and click Chart of Accounts.
B Click the Account button and then click New.

C Inthe Add New Account: Select Account Type window, select the
type of account you want to create and then click Continue.

Note: Refer to pages 65 and 66 for a description of the different types of
income, expense, and balance sheet accounts.

D Enter the account’s name in the Account Name field. This name will
appear on your company financial statements.

E If you want to make this account a subaccount of another account,
select the Subaccount of checkbox. From the drop-down list,
click the account that will be the higher-level account for this
subaccount.

Setting Up Your Business

Key Terms

Accounts

There are two types of accounts:

Balance sheet accounts track your assets and
liabilities (such as bank accounts or accounts
payable).

Income and Expense accounts are used to
track where your income came from and
what you spent the money on, such as office
supplies, rent, and utilities.

Refer to pages 65 and 66 for a description of
the different Reckon Accounts accounts.

Chart of Accounts

A complete list of your business’ accounts and
their balances. You use a chart of accounts

to track how much money your company has,
how much money it owes, how much money is
coming in, and how much is going out.

Did you know?

It is recommended that you open a business
current account for writing cheques as one
of the first things you do when starting a new
business.
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F  (Optional) Enter a short description, note, bank account number, or credit card number, depending on the type of
account you are adding.

G For balance sheet accounts, enter an opening balance based on the account’s balance as of your Reckon
Accounts start date. Generally, you should enter any balance sheet balances as of the day before your start
date. That way it’s all exactly correct at the opening of your start date. If you're putting money into the account
with a transaction, do not use the opening balance field, since this will create an additional transaction. If you're
not sure of the balance, you can leave the field blank and enter the information later. Click OK when finished.

H Click Save & Close or Save & New to add another account.

Why use Subaccounts?

When you need more detail about what’s going on in an account, you can divide the account into one or more
subaccounts. Subaccounts let you track several related types of income or expenses independently yet keep them
all under the “umbrella” of a single parent account. Subaccounts appear indented immediately below their parent
account in your chart of accounts. If you create subaccounts, it's best not to post anything to the “parent” account.
For example, if your business has substantial advertising expenses, you might decide to divide your Advertising
expense account into several subaccounts, such as Newspaper Ads, Signs, Yellow Pages Listing, and Direct
Mailings.

For a brand new account

When you create a brand new account, leave the opening balance at zero. Its opening balance will be created
automatically when you transfer funds from another account.

What type of account should | use?
There are two main types of accounts in the Reckon Accounts chart of accounts:

* Income and expense accounts



Setting Up Your Business

* Balance sheet accounts

Income and Expense Accounts

Income and expense accounts track the sources of your income and the purpose of each expense. When you record
transactions in one of your balance sheet accounts, you usually assign the amount of the transaction to one or more
income or expense accounts. For example, not only do you record that you took money out of your current account,
but you keep track of what you spent the money on (utilities or office supplies).

Account type Purpose

Income

Categorises money earned from normal business operations, such as product sales, service sales, and
discounts to customers.

Other income

Categorises money your business earns that is unrelated to normal business operations, such as dividend
income, interest income, and insurance reimbursements.

Expense

Categorises money spent in the course of normal business operations, such as advertising and promotion,
office supplies, insurance, legal fees, payroll, charitable contributions, and rent.

Other expense

Categorises money your business spends that is unrelated to normal business operations, such as
corporation taxes and penalties and legal settlements.

Cost of goods sold

Tracks the direct costs to produce the items that your business sells, such as cost of materials, cost of
labour, subcontractors, and shipping.

Note: Reckon Accounts does not display balances for income and expense accounts in the Chart of Accounts. To see these balances,
go to the Reports menu, click Report Centre, and then click the Company & Financial category. You can also select the income or
expense account in the chart of accounts and click FastReport.
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Balance Sheet Accounts

Reckon Accounts provides 10 types of balance sheet accounts to choose from as you create and add to your Chart
of Accounts. Use the type of account that best describes the type of data you are tracking.

Account type Purpose

Tracks money you have in your cash accounts. Create one for each cash account, such as petty cash,

Bank .

current, and savings.
Accounts receivable Tracks money your customers owe you on unpaid invoices. Most businesses require only the A/R
(A/R) account that Reckon Accounts automatically creates.

Tracks the value of things that you can convert to cash or use up within one year, such as prepaid

Other current asset :
expenses, employee cash advances, stock, and loans from your business.

Tracks the value of significant items (consult your accountant for a minimum cash amount) that have a

Fixed asset R A . . .
useful life of more than one year, such as buildings, land, machinery and equipment, and vehicles.

Tracks the value of things that are neither Fixed Assets nor Other Current Assets, such as Goodwill,

Other asset . . . .
long-term notes receivable, and security deposits paid.
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Account type

Accounts payable
(A/P)

Setting Up Your Business

Purpose

Tracks money you owe to suppliers for purchases made on credit. Most businesses require only the
A/P account that Reckon Accounts automatically creates.

Credit card

Tracks credit card purchases, bills, and payments. Create one for each credit card your business uses.

Other current liability

Tracks money your business owes and expects to pay within one year, such as tax or security deposits/
retainers from customers.

Long-term liability

Tracks money your business owes and expects to pay back over more than one year, such as
mortgages, long-term loans, and notes payable.

Equity

Tracks money invested in, or money taken out of, the business by owners or shareholders. Payroll and
reimbursable expenses should not be included.
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Setting Up Your Business | Adding Customers

s A
Click New Customer & Job to add
new customers to the list.

J

- A

View the amount of money each

Fle Edt Vew Lsts Company Customers Supplers Employses Barking Reports Window Help

Hame Comparny Snapshok  Customer Cerkre Suppler Centre  Employes Centre  Faport Centres  Onine Banking

Customers & Jobs l Transactions
View | Actwe Customers  w | =]

m @

Name Balarce Totsl

customer owes you in the
Total column.

~ A

Click a customer’s name in the
list to view the contact information

Ral — 0.00
#Eadeys Cellars 2,200.00

) #Bakar, Chits 0.00

#Eristol, Sanja 0.00

#Buldens Pty Lhd 0.00

#Bush, Jason 0.00

#Cagh Customers 0.00

#Hackians wal Company 9,350,00

New Customer & Job » 77| New Transactions » (= Printv ™) Ewcele [T, word»

Customer Information

BE #£# & h g & A"

Tax Invoice  Chegue Bl Accrit Bacdup  Suggest New Feature  Searc

TmaMhm.mnE.vmmlfj

Reports for this Custamer

and notes for that customer.

\ J
~ A

See all transactions for this
customer in the transaction list,
which can be sorted and filtered.

. J
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»Homebush Homes 660,00

#Layby Customer 0.00
#Cympic Park, 5,750.00
#Ripversal Customer 000
12,557.50
#Square Bocks Led £0.00
#Techman Engines Pty Lid 1,459.50

# Chents account
+ Clrits Trust

0.00
61,3625

Customer Hames Zaus Construction Certact Tschariss ] Juppanisen * QuitkRisport
Customer Type Corstruction Fhone 13235565 + Open Baignce
Compary bame Zaus Construction Took Pty Lkd Ak Phene . Show
Bilng Ackdbess Zacharias ). huppanisen Fax 32035565
Block C, Deve Street Emsd info@oeusedi.com
Sydney, NSW S065 Terms Due onreceipt
Price Level
Motes
-
Show [Alfransactions | Fiker by (A v Dae Al v
Tvpe tum Date Accourt: Amourk:
Tace Irrveice &1 15{01/2008 Ruceouris Recsiabie 24.315.25{ |
Tace Irweice &0 15{10/2007 Actourts Reosivable 11,746.25 |
Tae Irnveice =] 15{07 /2007 Rueouris Recsiabie 15,746.25
Tace Irveice 58 15042007 Aotourts Reosirable 11,746.25
Tacx Irvwoice 7 1501 f2007 Accourts Recsiysbls 11,746.25
Tace Irveice 5 15/10/2006 Actourts Reosirable 20,791.25
Tae Trnveice =5 15{07 /2006 Rueoirts Recsiabie 11,746.25
54 15{04/2006 Aotourts Reosiable 26,746.25
T Irnveice 53 15{01/2006 Ruceourts Recsiabie 11,746.25
Payment 03012006 RBC Bark 132,000.00
Tae Irnveice 52 15{10/2005 Rueourts Recsiabie 11,746.25
Tace Iriveice 51 15§07/2005 Actourts Reosivable 11,746.25
Tae Irnveice =0 15042005 Ruceoirts R e 11,746.25
Tace Iriveice 49 17fi3/2004 Aotourits Reosivable 11,746.25
Payant 02052004 FBC Bk, #,607.50
Payment 02j052004 REC Bank 2,029.50
Tae Irnveice 47 22{02[2004 Rueoints R et 7,468.75




Setting Up Your Business

Adding Customers Key Term

Customers are the lifeline of your business. By entering detailed Customers

information in Reckon Accounts about_ the people and compgnies t(_) Customers are the people or businesses to whom
whom you sell your products and services, you can personalise their you sell your products or services - that is, the people
bills, send invoices easily, and quickly view the status of their accounts. who pay you for what you do. Some businesses might

You can add new customers at any time refer to a customer as a client or member.

While typing in customer data for hundreds of customers can be a
tedious task, if you use Microsoft Outlook, you can import your existing Did you know?
customer information into Reckon Accounts instead of entering it

manually. Refer to the Reckon Accounts in-product Help for instructions Adding jobs
on how to prepare your customer data file for importing into Reckon If you are performing more than one job for a
Accounts. customer, you can track the jobs individually by
To add t . adding new jobs under the customer’s name in the
0 add a customer: Customers & Jobs list. That way, you can create
A Click the Customer Centre icon at the top of the Reckon Accounts reports that show the income and expenses for each
indow job. To add a job, click New Customer & Job and then
Wi : click Add Job.

B Click New Customer & Job and then click New Customer. )
Importing customers

C On the Address Info tab, enter all the data that you have about the If you need to add several customers to your Reckon
customer, including their name, Invoice to and Ship to addresses, Accounts company file, consider using the Import/
and additional contact information. Export functions to enter multiple customers at one

time. For more information, see Reckon Accounts Help

D Complete the Additional Info and Payment Info tabs, as for importing lists.

appropriate.
pprop Searching for customers

You can filter the Customers & Jobs list and Suppliers

list to display only certain items. This is a useful

way to find a particular list entry, or to display only a

particular set of entries.
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E

F Click OK or Next (if you want to enter another customer).

You can also add customers as you perform your everyday tasks. For example, if you enter the name of a new
customer when filling out an invoice, Reckon Accounts will prompt you to enter information about this customer. You

can choose from two quick setup options:

contact) to the list you choose.

Enter the customer’s name,
address, and contact
information on the Address
Info tab.

Use the Additional Info and
Payment Info tabs to set up
customer payment terms and
tax information.

-
Click Define Fields to create
any custom fields that you

need for your customers.
L 5

S

Customer Name

Fast Add - Adds just the name to the list. You must add the details later.
Set Up - Enables you to enter additional information (such as a phone number, tax number, and alternate

If you want to add additional fields to the form, click Define Fields to customise the form.

\ Andrew Rebak

1 rniny

Opening Balance | 1,000.00

H
| @5 of [15/12/2007 (] the opening balance?

Address Info ” dd

Categorising and Defaultg

Type
Terms

Rep

Mail

Construction
Net 30

Preferred Send Method

| Info ] Payment Info | Job Info |

ol s

_9

Tax Code

Country

Tax Information

Tax Reg. ID

Price Level

Custom Fields

o ]

Customer is
b

Go to Client
Manager

)
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Setting Up Your Business | Adding Suppliers

# Supplier Cantre: Georgian Plywood Import Co. (All Transactions) mamu-m@.vmmn

Click New Supplier to add new

suppliers to the list.

Supplier Informakion Edt Suppler... | Reports for this Supplier
Suppher Name  Geongian Plywood Impact Co. Cortact Ban Kibbls = QuickReprt
\ folene: 124 G + OpsnBssoce
Click a supplier's name in the list Supgiber Trpe Supples At Phone
to view the contact information -ftm:er-.-;r " mqmw]mmncc: Fax o
. A {17 Erma
and notes for that supplier. o et Inport s osorsiamoou oo, com
Eaary Bay
Sydney, NSW 2155

4 N\ b £t Mlokes...

View the amount of money you

owe each supplier in the Balance Show | Al Transactions w| FlerBy (a1 v | Date |

@tal column. - Type e Date * Acoount Amourt
[tem Fieceipt 02/1272006 Acoounts Paysble ~44,431.82 &
Item Receipt 15]1072005 Acoounts Payable -13,636.37
Ikem Reeceipt 2200472004 Acconnts Payskle -10,650,00

' N\ Bl Pt -Cheque 20j03[2004 2BC Bank -2,000.00

See all transactions for this Bl Pt -Chegue 1503200 ABC Bank +5,000.00

supplier in the transaction list, - H7fE Accounts Paystle +11,000.00

which can be sorted or filtered. el 25if2003 £BC Bk el

) Bl Pt -Chegus 2Bj02fz00 ABC Bark -2,268.75

] 2410272003 Accounts Paystle +7,567.50
ol 24f00/2003 Accounts Paystle -2,260.75
] 13012003 Becounts Payskle -1,31.28
Credt 13/01/2003 Acoounts Paysble 181.50
0l Frnk, -Chagues 1300152003 ABC Bank -1,170.75
ol OHOLZ00I Accounts Paysble -2,407.50
ol Pt -Chagus 03j0Lf2003 2BC Bank -7,272.50
[ 12/1212002 Accounts Payable -4,865.00
0l Frok, -Chagus 21002 ABC Bank -B,313.75
] 1Hfiofz00 Acomnts Payable 531375
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New Supplier: Additional Info

Enter the supplier's name,
address, and contact
information on the Address

Info tab. 3
o
AccountNo. || ']
( ays B h Custom Fields
Use the Additional Info tab Categorising and Defaults
to enter supplier-specific 5 pe

information, including the
L supplier type.

e —

6 Tax Information

(Click Define Fields to create
any custom fields that you

|| TaxCode
need for your supplier. i

Tax Reg. ID

Country
(e —

X

Adding Suppliers

Reckon Accounts uses the supplier list to hold information about the people and companies you buy goods and
services from to run your business; for example, this list could include the phone company, your office stationery
supplier, and your Utilities provider. You can add new suppliers at any time.
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While typing in supplier data for hundreds of suppliers can be a tedious
task, if you use Microsoft Outlook, you can import your existing supplier
information into Reckon Accounts instead of entering it manually. Refer
to the Reckon Accounts in-product Help for instructions on how to
prepare your supplier data file for importing into Reckon Accounts.

To add a supplier:

A Click the Supplier Centre icon at the top of the Reckon Accounts
window.

B Click New Supplier.

C On the Address Info tab, enter all the data that you have about
the supplier, including their name, address, and additional contact
information.

D If you owe the supplier money as of your company’s start date,
enter the amount in the Opening Balance field.

E Click the Additional Info tab and complete the form.

F If you want to add additional fields to the form, click Define Fields
to customise the form.

G Click the Bank Details tab and complete the form.

H Click OK or Next (if you want to enter another supplier).

Setting Up Your Business

Key Term

Suppliers

Suppliers are any businesses or people from
whom you buy or rent goods or services for your
business - office supplies, phone or computer
services, or products that you sell. The tax
agencies that you pay are also your suppliers.
Nearly everyone you pay other than employees
are suppliers.

Did you know?

Importing suppliers

If you need to add several suppliers to your
Reckon Accounts company file, consider
importing all your suppliers at the same time.
Refer to the in-product Help for instructions on
how to import lists.
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You can also add suppliers as you perform your everyday tasks. For example, if you enter the name of a new supplier
when paying a bill, Reckon Accounts will prompt you to enter information about this supplier. You can choose from

two quick setup options:

* Fast Add - Adds just the name to the list. You must add the details later.

e Set Up - Enables you to enter additional information (such as a phone number, tax number, and alternate

contact) to the list you choose.

Setting Up Your Business | Adding Items

For inventory parts, the

On Hand column shows how
many of each item you have
in inventory.

Stadium Construction & Hardware Pty Ltd EEX
File Edit View Lists Accountant Company Customers Suppliers Employees Banking Reports Window Help
@

& 6 4
Home | Customer Centre Supplier Centre Employee Centre = Report Centre | Online Banking

B B ® £ & & H

© TaxInvoice Item MemTx Cheque Accnt  Pay Tax

B jtem List

»Concrete Slab

+Installation Installation Service i Service Income

+labour i Services

oLegal Services ILegal Services i Professional FeesiLeg...

+Special Order i Sales Income

+Bathroom Tiles [Bathroom tiles 6.00

181.81818
2,500

(Subitems are indented under
the parent item.
X

P
Click the Item button to add
new items or perform activities

Lon existing items.

0
0
0 )
0| 18.18182
i 5 0 1.00
oKitchen Taps (Gold-ined Kitchen Taps Inventory Part |Completed Units 43 0
oLadder [4m Steel Ladder Inventory Part |Completed Units 1 0
sOveralls (Overalls Inventory Part [Others 2| 0
oPaint Indoor/Outdoor Paint Inventory Part |Construction Parts 0| 0 .00
Fence Paint [Brown Fence Paint Inventory Part |Construction Parts % 0 X
i i Inventory Part |Construction Parts 8 0 .
Undercoat Paint [Paint Undercoat Inventory Part |Completed Units 75| 0
istant Paint i Inventory Part. |Construction Parts 152 of 4200
oPaint Brush Inventory Part |Completed Units o 0 0.00
Big Paint Brush Big Paint Brush Inventory Part |Completed Units 62 0| 11.59091
<Premier P Pan! Brush Premier Paint Brush Inventory Part |Completed Units 25 0 2
+Small Paint [small Paint Brush Inventory Part |Completed Units 58 0 25
Roof Tiles [Red Roof Tiles Inventory Part |Completed Units 230 0 4.50
o Timber Inventory Part |Completed Units 0| 0 0.00
+Cedarwood 44 Cedarwood Timber Inventory Part |Completed Units 103 of 4750
Red Timber 3%4 Red Plywood Inventory Part |Completed Units 50 of 47.00
S St Timber elpeae] Timber Inventory Part |Completed Units 30 ol 90.00
0

Inventory Part_|Completed Units 82] 3.18182 v

—9——[ TR




Setting Up Your Business

Adding Items Key Term

In Reckon Accounts, an item is anything that your company buys, sells,
or resells to run your business. Items are your products, services, and
things such as discounts and shipping and handling charges.

Items

An item is anything that might appear as a
line item on an invoice, including subtotals,

When you choose an item from the Item list, Reckon Accounts fills in a discounts, and tax, as well as the products and/
description of the line item and calculates its amount for you. or services that you sell. You enter items on
your invoices and sales receipts. For example,
Reckon Accounts provides 9 different types of items, described in the a writing consultant might set up one item
table on page 77. Some items, such as service or inventory part items, for editing services with an hourly rate, and
help you record the services and products your business sells. Other another item for writing services with a different
. Py A P . y : hourly rate. On an invoice, the items would be
items, such as the subtotal or discount items, are used to perform entered with the number of hours worked as the
calculations on the amounts in a sale. quantity.
To add an item: While providing a quick means of data entry,
. . . items also handle the behind-the-scenes

A Go to the Lists menu and click Item List. accounting. When you create an item you link it

. . . to an account. When the item is used on a form
B Click Item at the bottom of the list and then click New. it posts an entry to that account and another to

the appropriate accounts receivable, accounts

C Click the Type drop-down arrow and choose the type of item you A S M

want to create. (See table on page 77.)

D Enter an item name as you want it to appear on purchase and
sales forms.

E Enter the description that you want to appear on sales forms when
you use the payment item.

F In the Rate field, enter the amount you want to charge for the item.
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G In the Tax Code list, select the appropriate tax code or create a new one. If you do not see the Tax Code list, you
must turn the tax preference on in the tax area under Edit | Preferences.

H In the Account field, choose the account that is associated with this item. (In most cases, you will assign the
item to an income account.)

| Click OK or Next (if you want to enter another item).

Choose the type of item you I

want to create from the Type _e_ | "pe S
5 ist. Sl specialised labour, consulting hours, or ’ _
Kdrop down list ) Tocklesd dou,
p N Ttem {Nurmb [] subitem of Custom Fiekd
Click the Custom Fields button [ |
to set up and fill in custom REcieets Speling
fields that you need for your Enable...
items.
- J [ This service is used in assemblies or is performed by a subcontractor or partner
N Description Rate [ Amts Inc Tax
Enter the amount you want to _6
charge for the item here. [, &
L g ) Tax Code v
Acont | | v
~ How can I set rates by customers or employees?
Choose the appropriate Tax | —@
Code here. Bacode [ |
o
. . . h
Associate the item with an _e
account here.
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Setting Up Your Business

Which Item Type Should | Choose?

Reckon Accounts provides 9 different types of items to help you fill out sales and purchase forms quickly.

Item Type Purpose

Service

Use for services you either charge for or purchase, like specialised labour, consulting hours, and
professional fees.

Inventory part (available in
Reckon Accounts levels Pro
and above)

Use for goods you purchase, track as inventory, and resell.

Inventory assembly (available
in Reckon Accounts levels
Plus and above)

Use for assembled goods you build or purchase, track as inventory, and resell.

Non-inventory part

Use for goods you buy but don’t track, like office supplies, or materials you buy for a specific job
that you charge back to your customer.

Other charge

Use for miscellaneous labour, material, or part charges, such as delivery charges, setup fees,
and service charges.
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Item Type

Purpose

Use for showing sum of all items above it on a form, up to the previous subtotal. Useful for

| . . L
Subtota applying a percentage discount or surcharge to multiple items.
Group Use for associating a set of individual items that often appear together on invoices, purchase
orders, and so on, so that all items in the group can be added to the form at one time.
Discount Use to subtract a percentage or fixed amount from a total or subtotal. Do not use this item type
for an early payment discount.
A Use to record a partial payment you received at the time of a sale. It reduces the amount owed

on an invoice.

Why item types are important

Although you can use items as a quick means of entering data, items fulfil a much more important Reckon Accounts
role: to handle the behind-the-scenes accounting.

When you create an item, you link it to an account; when the item is used on a form, it posts an entry to that
account and another entry to the appropriate accounts receivable, accounts payable, current, fixed asset, or other

account.

While items are easy to set up, you should spend some time deciding how they can best work for you before you
start setting them up and using them. Use your current list of services and products as a starting point. Consider



Setting Up Your Business

how much detail you want on your invoices or statements and set up your items with that level of detail in mind. For
example, if you are a seamstress who creates and sells home accessories, you can set up a single item and charge
a flat rate for a certain size of couch pillow, or you can break that pillow down further into labour and materials.

Furthermore, Reckon Accounts provides many useful reports that break information down by the goods or services
you purchase and sell. That way, you can quickly find out:

* How much income your items bring in
* What you are spending to purchase items
* How well you estimate the cost of items

e How much time you spent on each type of job or item
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Setting Up Your Business | Setting up tax

How tax tracking works in Reckon Accounts

Assign
Tax Codes
to your
items.

Sell items Buy items
& i [ e some P o] ®

e e o o]

ot s+ Qe+ Birrd o webg Rorny

o Descrpion. = oA 0 = i
e g ot om
= EEEmlc L =
= e

Conwacon ) Coomtir ] (ke )

Invoice Enter Bills

Reckon Accounts tracks your output tax Fill in your tax return, and send
and input tax in the Tax Liability your payment to your tax agency.
account, which Reckon Accounts creates
by default.
& Goto... < GPrnt... [EG Transaction [5] QuickReport
Date. Number s;T- Due Date Bled |/ pad Bance ||
oo [z [t T ttes [oizizon ol a8
10/01/2008 "u" Ammmc!h [31/12/2008 0.64| 47,267.39 L__.,\ ; :
15j01/2008 ? e T 2215.0] P50 F:' Coem——— - [comicreanv]
, e =E
endeg baence P T [ 5] Dlmemsvasem | Toatemfin |
O 1-tine
mlw (ote Type, Munbrt.. v (Crecarg ) (Crestore ] (o s ) e ] S ) (gemanm ) Gew )
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Setting Up Your Business

Setting up tax

If you are registered to collect tax, you need to enable tax tracking in Reckon Accounts. Reckon Accounts then tracks
the tax that your company pays on expenses, reclaiming it from the tax that you collect and pay to your tax agency.

Reckon Accounts supports the two most common tax schemes: Standard Accrual Tax Accounting and Cash Tax
Accounting.

e Standard Accrual Tax Accounting scheme: you track tax on sales and purchases when you send an invoice or
receive a bill, and very likely before you have received any money for these transactions from your customers.

e (Cash Tax Accounting scheme: you pay and reclaim tax only on the basis of cash received and cash paid out by
you. This scheme is meant to help smaller businesses with their cash flow. To qualify, your annual turnover must
be below a certain value.

Important: You must follow the rules and regulations from your tax agency for collecting and paying tax.

Understanding how tax works in Reckon Accounts

You use tax codes on transaction forms to set how tax applies to the products and services that you buy and sell. For
example, when you create an invoice, you assign an appropriate tax code to each line item on the invoice.

Each tax code is associated with one or both of a tax item for sales, and a different tax item for purchases. This lets
Reckon Accounts properly track both output tax (from your sales) and input tax (from your purchases).

Reckon Accounts uses tax items to calculate and add tax charges when you make a taxable sale. When you set up
a tax item, you assign a tax rate to it and associate it with the tax agency to which you pay the tax. After you enable
and set up tax, Reckon Accounts applies the appropriate tax rate to the sale of your taxable items, based on the tax
code.

Tip: Reckon Accounts sets up default tax codes, tax items, and your tax agency for you. These become available when you enable
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tax, either from the Setup Interview or through the Preferences window.

Preferences: Set tax preferences

X

Verify that you have tax = accounking ittbeteresl Cormpemy Prefereace: | =]
turned on. -ﬁ BaTRINg Do you track tax? ® Yes Ono
2 :i:zkop - Do you want to edit tax amounts? OYes ® o
ey Finance Charge Default
@ General Default Tax Agency
. 4 mmteqrated Applications Tax reporting basis Sales figures Also See:
Choose settings that reflect | & ttems t inventry ® Accrual Basis (Standard Tax Accounting) () Net (Exclusive of GST) General
the way you mana ge tax. I =t Jobs & Estinates O Cash Basis (Cash Accounting Scheme) O Gross (Inclusive of GST)
% Online Return due day(s) after the reporting period ends
q Payroll & Employees
@ Reminders
lul Reports & Graphs Default Tax Code
Q Sales & Customers
Q Send Forms Allow tax inclusive (gross) prices and costs to be entered.

Setting up tax

If you need to make changes to how tax is configured, you need to know the following:
* Tax rates for the new tax situation that you need to handle.

* Tax agencies to which you pay the collected tax.

Setting up tax is a three-step process:

* Step 1: Enabling tax in preferences
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e Step 2: Setting your tax reporting period
* Step 3: Entering an opening balance for your tax payable (what you owe)

Don’t forget to specify your Tax Rego ID (ABN) in the Company Information window. (Go to the Company menu and
click Company Information.)

Tip: Reckon Accounts includes a Manage Tax window to help you complete your common tax tasks, like setting tax preferences,
creating tax reports, and paying tax liabilities. To open this window, go to the Suppliers menu, click Tax Activities, and then click
Manage Tax.

Step 1: Enabling tax in preferences

In this procedure, you'll turn on tax and then set up basic information about how you report tax to your tax agency.
To set up your tax payment schedule:

A Go to the Edit menu and click Preferences.

B In the scrolling list on the left, click Tax.
C Click the Company Preferences tab.
D

For the question Do you track tax?, click Yes.

Step 2: Setting your tax reporting periods

Your tax reporting periods are when and how often you need to file tax with your tax agency. You set this up in the tax
supplier (i.e., the tax agency’s supplier) record. While Reckon Accounts creates the supplier record for you, you still
have to specify the tax reporting period yourself.

To set up your tax reporting periods:
A Open the Supplier Centre (go to the Suppliers menu and click Supplier Centre).
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In the lists on the left side of the screen, click the Suppliers tab.
Double-click the supplier used to pay tax. Typically, this is “Australian Taxation Office”.

In the Edit Supplier window, click the Tax Agency Info tab.

m O N @

In Period and Period Ending, select the schedule at which you file tax. For example, if you file tax four times a
year at the end of March, June, September, and December, choose a Period of “Quarterly” and a Period Ending
of “Mar/Jun/Sep/Dec”.

F  Click OK to close the Edit Supplier window.

Step 3: Entering an opening balance for your tax payable (what you owe)

You need to enter an opening balance for your Tax Payable account (what you owe as of your Reckon Accounts start
date). After your start date, your tax is included on your sales forms and entered into this account.

Caution: Do not do this if you entered all historical invoices or sales receipts dated before your Reckon Accounts start date. Your
tax will already be included on them and posted to this account.

Default tax codes

When you enable tax Reckon Accounts sets up the following tax codes by default. In most cases, these will be all

you’ll need.
Tax code Description Linked to Tax Iltem
ADJ-P — Purchases
ADJ Tax Adjustments
ADJ-S - Sales
CAF Cap. Acg. - GST Free CAF
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Tax code Description Linked to Tax Item
CAG Cap. Acq. - Inc GST CAG

CAl Cap. Acq. - for making Input Taxed Supplies CAl

cDC Combined Cellar Door CDC Tax Group
CDG Cellar Door GST CDG

CcDS Cellar Door WET CDS

EXP GST Free Exports EXP

FRE GST Free Supplies FRE

GST 10% GST GST

INP Input Taxed Sales INP

NCF Non-Cap. Acqg. - GST Free NCF

NCG Non-Cap. Acq. - Inc GST NCG

NCI Non-Cap. Acq. - for making Input Taxed Supplies NCI

wce Combined WET & WGST WC Tax Group
WET Wine Equalisation Tax WET

WGST GST on Wine Equalisation Tax WGST

Default tax items

When you enable tax Reckon Accounts sets up the following tax items by default. In most cases, these will be all
you’ll need.
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Tax item

Description

Rate

Agency

Sales or Purchase

ADJ - S Tax Adjustments (Sales) 10.00% Default S
ADJ -P Tax Adjustments (Purchases) 10.00% Default P
CAF Cap. Acq. - GST Free 0.00% Default P
CAG Cap. Acq. - Inc GST 10.00% Default P
CAl gigpl/-l\gg - for making Input Taxed 0.00% Default P
CDG Cellar Door GST 11.90% Default S
CDS Cellar Door WET 18.98% Default S
EXP GST Free Exports 0.00% Default S
FRE GST Free Supplies 0.00% Default S
GST 10% GST 10.00% Default S
INP Input Taxed Sales 0.00% Default S
NCF Non-Cap. Acg. - GST Free 0.00% Default P
NCG Non-Cap. Acg. - Inc GST 10.00% Default P
NCI ?a?(r;gaspljpﬁ% .s_ W7 AT e 0.00% Default P
WET Wine Equalisation Tax 29.00% Default S
WGST GST on Wine Equalisation Tax 12.90% Default S
5 CDG 11.90% +CDS

Combined Cellar Door 18.98% Default S
(Tax Group)

=30.87%
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Tax item Description Sales or Purchase

WET 29.00% +WGST
Combined WET & WGST 12.90% Default S
= 41.90%

wcC
(Tax Group
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Setting Up Your Business | Setting Up Your Payroll

- ) # Employee Centre: Payroll Centre. m m El
Click to switch between your e B0 Reckon Supertink

Employee list, Transactions
list, and Payroll Activities

A

status. B becember- 20090 2 o ;,..,.M mmmmm,#‘&%m xample » ood
Su Mo Tu We Th Fr Sa Pay N
How do I pay my emplovees? Set up your payroll schedule.
6 7 ; ;l: l: l: Eibpiuyeoy
( Fetbl l e ) (rboores ] i
Pay Employees: Run payroll 72T
and perform ongoing payroll -
activities from this section. January - 2010 Liabilties

Su Mo Tu We Th Fr Sa
12

34 5 6 7 8 9
1011 12 13 14 15 16
17 18 19 20 21 2 23
25 2% 27 28 29 30

-
Pay Liabilities: Track and pay
your payroll liabilities or
make adjustments in this
section.

v

Setting up your Payroll

Paying employees is a big responsibility. You have to calculate gross and net pay, tax and superannuation, as well as
track the liability payments you need to send to the Australian Taxation Office and benefit agencies.

Setting up Reckon Accounts Payroll

Reckon Accounts includes step-by-step instructions that take you through setting up payroll for your business. You
need to set up your payroll items, your employees, and set your employees’ year-to-date (YTD) amounts.
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Tip: Depending on the size of your company, payroll setup can take a long time to complete. Before you begin setting up payroll,
we recommend you gather all of the information in the Payroll Setup Checklist.

The following sections describe common activities you will perform during payroll setup.

Setting up Payroll Items

You add payroll items to payroll payments the same way you add items to invoices. Payroll items track amounts

such as wages you pay and taxes you deduct from your employees’ payroll payments. There are payroll items for
commission, taxes, other additions and deductions, and employer-paid expenses. You can assign these payroll items
to different accounts as needed.

By default, Reckon Accounts creates common payroll items that you’ll need, such as tax deductions and
superannuation. However, you may need to add other payroll items for your own company.

To create a payroll item:

A Go to the Lists menu and click Payroll ltem List.

B  From the Payroll Item menu button, choose New.
The Payroll ltem Wizard opens.

C Choose the type of payroll item you want to create and click Next:
*  Wage: Money you pay to employees for salaries, hourly wages, commissions, and Paid Parental Leave
e Addition: Money you pay to employees above their base earnings, such as a bonus
¢ Deduction: Money you deduct from your employee other than taxes, such as life insurance
e Company Contribution: Company-paid benefits for your employees
e Superannuation Contribution: Company and employer contributions

D Follow the onscreen instructions. When you're done, click Finish.
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Entering year-to-date amounts for your employees

If you begin using payroll part way through the current tax year, you must enter year-to-date amounts for each
employee that you've paid thus far in the tax year. In Australia, PAYG is calculated on a cumulative basis, so Reckon
Accounts needs to take into account an employee’s total pay and tax amounts for a given tax year in order to be
able to deduct the right amount of tax from his or her pay.

You can use the Year-to-Date Wizard to help you enter year-to-date amounts for your employees.

Follow the steps below to summarise and enter the payroll payments you processed for each employee from the
beginning of your financial year (e.g., in Australia this is July 1) to the date that you started using Reckon Accounts
Payroll.

To summarise and enter year-to-date amounts for each employee:
A From the Employees menu, click Payroll Setup, then click the YTD Amounts tab.

B Follow the onscreen instructions until you get to the Employee YTD summary information window. Select an
employee from the list and click Enter Summary.

The YTD Adjustment window opens.
C Enter the details of the year-to-date payroll amounts for this employee.

We recommend that you create one entry to summarise the payroll payments that you've paid to this employee
thus far.

D Click OK, then select the next employee.

E Click Finish when you are done, or if you need to enter prior payroll liability payments, click Next and refer to the
steps below.

To learn more about entering year-to-date amounts, see the in-product Help.



To enter prior payroll liability payments:

Setting Up Your Business

A Open the Year-to-Date Wizard as described in the steps above.

B Follow the onscreen instructions until you get to the Summarising prior liability payments window.

C Click the Prior Payments button to enter a summary of all the taxes and liability payments you’'ve made to the

government.

Payroll Setup Checklist

Before you begin setting up your payroll, you should gather the information listed in the following table. You can
find this information in your own records, from your accountant or Reckon Accredited Partner, or from government

agencies.

Information Reckon Accounts needs Where to find it

Tax office number and reference

Your accountant or company records

Current tax tables covering payroll withholdings

Your tax agency or download from Reckon

How you pay your employees and directors (hourly wages, salaries,
and/or commissions)

Your accountant or company records

How often you pay your employees

Your accountant or company records

Additions you make to your employees’ pay that increases their
earnings base (bonus payments, statutory payments, etc.)

Your accountant or company records
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Information Reckon Accounts needs

Deductions you make to your employees’ pay (student loan
repayments, union dues, employee loans, health insurance, etc.)

Where to find it

Your accountant or company records

Payroll expenses that your company pays

Your accountant or company records

Employee personal information (Tax File Number, date of birth,
contact details)

Your accountant or employee records

Employees’ rate of pay and payroll payment additions, deductions,
and employer contribution amounts

Payslips, reports, or your accountant

If paying using direct deposit, employee’s bank or building society
details (account number, name of account holder, bank name and
address)

Employees

Holiday and personal leave accruing policies and amounts

Existing payments, reports

Total employee payroll amounts that you've paid out so far this
payroll year up to the date you start using Reckon Accounts,
including amounts withheld from payroll payments, commissions,
and bonuses

Copies of employee payroll payments, payslips, previous
accounting software or service provider, reports, your
accountant or company records

If you are already operating payroll, total amount of PAYG income
tax owed to your tax agency as of your start date

Previous accounting software or service provider,
accountant or company records




Setting Up Your Business | Setting up Employees

ol

Enter the employee’s personal
information, including the
name to be printed on their
payroll payments.

-

-

Enter the employee’s address\
and contact information in the
Address and Contact tab.

New Employee

Information for: Douglas Beagle

Setting Up Your Business

Change tabs: |personal Info

V,l Cancel

[ Personal

] Address and Contact j

Additional Info

Next

M.

Legal Name

mi[]

Lt e
Grikes Douglas Beagle

Gander
Date of Birth |06/12/1984 B

Dispbility
Disgbled

A

O Employee is
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Select a payroll schedule
that you have set up.

Enter employee basic earnings
information.

Set up the employee’s tax
information.

Enter how much personal
leave and how many holidays
the employee has accrued and
used thus far.

New Employee Type a

Information for: Douglas Beagle

|

Change tabs: [Payroll and Compensation Info

9

Payroll Info

Earnings
Item Name Hourly/Annual Rate |
Salary

45,000.00 4~

v

[[] Use time data to create paycheques

What is a payrgll schedule?
Schedule weekly b
pay Freguency [ 1oy ]
Pay Methad

Class

Additions, Deductions and Company Contributions

Amount Limit

-5.00

Item Name
Union Fees

|

Leave Details...

Enter employee benefits and
deductions.

If paying by direct deposit,
click the Direct Deposit button
and enter the employee’s bank
account information.

Direct Deposit
[ Super Details. .. 3—
]

Raisgs & Promotions

Cancel

Bext

Employee is
a inactive

Enter additional employee
information including super
fund details such as name and
current rate.

Click the Raises & Promotions
button to enter a raise or
promotion or historical record
using Employee Organiser.




Setting up Employees

To process payroll payments and prepare tax documents for your
employees, you need to enter specific information about each of your
employees in Reckon Accounts.

Refer to the Payroll Setup Checklist on page 91 for a list of employee
information to gather.

To set up an employee’s personal information:

A Click the Employee Centre icon at the top of the Reckon Accounts
window.

B Click New Employee.
C On the Personal tab, fill in the form.

D Click the Address and Contact tab, fill in the form, and then click
OK.

E  When prompted to set up the employee’s payroll information, click
Leave As Is. Or, continue with the instructions below.

To set up an employee’s payroll information:

A Click the Employee Centre icon at the top of the Reckon Accounts
window.

B Click the Employees tab and then double-click the employee’s
name.

Setting Up Your Business

Key Terms

Earnings Base

An earnings base is the wages or earnings

due to an employee before any deductions are
made. It is also referred to as gross pay or
taxable income. An employee's earnings base
can include wages, salaries, overtime, bonuses,
and commission. Reckon Accounts uses the
earnings base to work out payroll withholding
amounts, such as tax.

Directors

A director is a person who, traditionally,
manages the business of the company on a day-
to-day basis.

For more information on directors, refer to the
in-product Help.
Hire an Employee Wizard

The Hire Employee wizard guides you through
the process of hiring an employee.

Go to the Employees menu, choose Employee
Organiser, and then click Hire Employees.

For more information, refer to the in-product
Help.
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From the Change tabs drop-down list, click Payroll and Compensation Info.
Fill in the Payroll Info form.
Click the Taxes button. Fill in the form, based on the employee’s tax information.

Click the Leave Details button. Fill in the form to specify how personal leave and holidays are accrued.

If you pay the employee using online banking, click the Direct Deposit button to set up the employee’s bank
account information.

H Click the Super Details button. Fill in the form to set up the employee's superannuation information.
Click OK.

Once you've set up your employees, refer to “Paying Employees” on page 122 to learn about paying them.



Money In | Creating an Estimate

Print and mail or email
estimates to your customer.

Customer:Job_[Commercial]

When you're ready to bill the

this estimate to an invoice.

customer, click here to convert

S - = ]
D previous B Next & Print vIQEmai ~ € Find & Speling Xy History [ createInvoice ~ [4 Customise ~ [ Letters ~

Choose items to add to the
estimate or create new items.

[ Estimate Class Template
Andrew Rebak v |~ Active v/ |custom Estinate v
- Date
Estimate 12/10/2009 () |3
Commercial Couriers
Andrew Reback
13 Roebuck Street
North Narrabeen NSW 2010
Ttem Description Qty  Rate Amount  Markup  Total Tax | ThxAmt |
Concrete Slab__|Foundation Skab - prep and pouring 15 2000 30000 175.00(  475.00 GsT 47.50 A
— ]
v
S:;tnm:v Thank you for your :I., Total Taxes 47.50
5age |business.
Total 30000 17500 52250
[JTobeemailed Customer Tax Code |GST v : - N N N
] Amounts include tax =
Memo Save & Close ve & New Clear

Choose the Estimate template

you want to use, or create
your own.
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Creating an Estimate

You can use the estimate form to prepare estimates, bids, quotes, or proposals for your customers. You can change
the title “Estimate” to anything that suits your business.

Note: Estimates are available in Reckon Accounts levels Pro and above.

Filling in the estimate is similar to creating an invoice. And when it’s time to bill your customer, you can create the
invoice directly from the estimate by clicking Create Invoice on the estimate’s toolbar. Reckon Accounts then creates
the invoice, with all the information from the estimate filled in. Later, you can create reports that compare your
estimated costs and revenue against your actual costs and revenue to see how accurate your estimates are.

To create an estimate:

If necessary, turn on Estimates (described below), if you didn’t do this during the Setup Interview.
Go to the Customers menu and click Create Estimates.

Enter the name of the customer or job.

Select an estimate template from the Template drop-down list.

Fill in the estimate form.

Click Print.

A M m g N ©@ >

Save the estimate.

To turn on the estimates feature:

A Go to the Edit menu and click Preferences.
B Click Jobs & Estimates in the list on the left and then click the Company Preferences tab.

C Click Yes to the question, “Do You Create Estimates?”



Money In

To have Reckon Accounts warn you when you try to record an estimate with the same number as the existing
estimate, select the Warn about duplicate estimates numbers checkbox.

If you do progress invoicing:

* Make sure Yes is selected in response to the question, “Do You Do Progress Invoicing?”

Specify whether you want line items that have zero amounts to print on your progress invoice
Click OK.
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Print and mail or email
invoices to your customer.

Money In | Creating an Invoice

Create Invoices

W

Choose items to add to the
invoice or create new items.

B Create Invoices Type ahelp question E.v How Do l?-@
Dprevious P next Gprint v CJEmal ~ ELFind [ Speling By History ] Journal [ Letters ~ [I4 Customise ~
Customer:Job [Commercial] Class Template
Andrew Rebak v| v

[Stadum Tax Invoice (V|
Date

12/10{2009 (&| |75

Tax Invoice

Commercial Couriers
Andrew Reback.

13 Roebuck Street
North Narrabeen NSW 2010

o

Ttem Description Qty  Rate  Tax TAX AMT Class Amofint ]
Concrete Slab Foundation Slab - prep and 15 31.66... |GST 47.50 475.00 A~
pouring
™
Customer [Thank you for your v Total Taxes 47.50
Message |business.
Total 522.50
To be printed Apply Credits... | Payments Applied 0.00
[[] To be emailed Balance Due 522.50
Customer Tax Code *
] Amounts include tax e Tex Code |c57_

Save & Close save &New | | [ Clear

?

Choose the Invoice template
you want to use or create
your own.




Creating an Invoice

When your customers don’t pay you in full at the time you provide your
service or product, or when they pay in advance, you need to track how
much they owe you. You can use an invoice to help you keep track of
what your customers owe you (or your “accounts receivable”).

Invoices list all the details about the sale, including the services you're
providing or the products you're selling (your “items”). Invoices also
show the quantity and price or rate of each item. If you need to make
automatic adjustments to prices (for example, discounts or markups),
invoices will work for you.

Note: If your customers pay in full at the time of purchase, do not create an
invoice. Instead, create a sales receipt, described on page 103.

To create an invoice:
A Go to the Customers menu and click Create Invoices.

B In the Customer:Job drop-down list, click the name of the customer
or job.

C Click the Template drop-down arrow and then click the invoice
template you want to use.

D Click the Terms drop-down arrow and then click the sales terms
that apply to this customer.

E In the lower part of the form, enter each of the items (including the
proper quantity) that the customer has purchased.

Money In

Key Term

Estimate

An estimate is a form you use to itemise the
work you propose to do or the products you
intend to sell to a customer. Your company
might use a different term, such as bid, grant, or
proposal. Estimates are optional, not mandatory,
for all businesses.

Did you know?

Using sales orders

In Reckon Accounts levels Pro and above, you
can create sales orders to help you keep track
of items that your customers have ordered but
you have not yet delivered to them, for example
because you do not have them in stock.

Refer to the in-product Help for instructions and
tips on how to use sales orders.
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F  Click Print on the toolbar to print the invoice now. Optionally, you can select the To be printed checkbox to print
the form later.

G Save the invoice.

Tip: You can customise your invoices (or any other sales form) for your business. Click Customise to open the Basic
Customisation window, where you can add your company logo, change fonts and colours, and access more advanced options.

Selected Template Preview
Stadium Tax Invoice
N Tax Invoice
B .0go & Fonts.
Print your company logo on Fliss o
your invoice.
Selectculousdwn_e:
Change Font For:
. T Change Fort...
Choose different fonts to Compary Rare 208 Fort
¥ ompany ress
use for different parts of Labels
. . ata
the invoice. Subtotals Label
Total Label
Company & Transaction Information
Control what type of [7] Company Name (] Phone Number
information gets printed [7] Company Address [ Email Address
on your invoices. [ Fax Number [] web Site Address T
ianes DU
e [ |
Print Status Stamp
. This controls whether the status stamp is printed.
C||Ck here tO aCCe.SS I:T]Ore e.g. PAID, PENDING, RECEIVED etc.
advanced customisation
options. ——r—— - Addtional J (Crovoutvesigner... J[ conel | o ]
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Money In | Entering Sales Receipts

Entering Sales Receipts

When your customers pay in full at the time they receive your service or
product, you don’t need to track how much they owe you. However, you
might want to record the sale, calculate its tax, or print a receipt for the
sale. In these cases, you can create a sales receipt.

Examples of businesses that commonly use sales receipts include
hairdressers, beauty salons, and DIY shops.

Note: If you need to track how much a customer owes you or you do not receive
full payment at the time of the transaction, do not use a sales receipt. Instead,
create an invoice, described on page 101.

To enter a sales receipt:
A Go to the Customers menu and click Enter Sales Receipts.

B Fill in the top part of the form, including the Customer:Job, Date,
and Payment Method.

C Click the Template drop-down arrow and then click the sales receipt
template you want to use.

D In the bottom part of the form, select or enter the items purchased.

E Save the transaction.

Money In

Key Term

Invoice

An invoice is the form you use to charge
customers for the products and services they
purchase from you.

Did you know?

You can create an invoice letter directly from the
invoice form by clicking the Letters button on the
Create Invoices toolbar. Refer to the in-product
Help for more detailed information about this
feature.
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R, Enter Sales Receipts

TyDeahOsz(ionlE.v How Do n

Choose the Sales Receipt Dprevious BPhext Gprit ~ [JeEmal ~ EFind [ Speling By History ~ ] Journal  [}4 Customise ~

template you want to use or o Template (Prin Preview )
create your own. e Rabel v v

Custom Sales Receipt v

z z Date 3
Sales Receipt\Tax Invoice a

Commercial Couriers
Andrew Reback

13 Roebuck Street
North Narrabeen NSW 2010

Item Description

Qty Rate Tax TAX AMT Class Amount = |

Choose items to add to the [ier 5 20.0016eT 30.00 300.00] &

Sales Receipt or create new 4 v
items. E“:”:”{*' s boen a loasure v Total Taxes 30.00
Total 330.00

[ Tobe emaled  Customer Tax Code [G5T v |

j Memo
[] Amounts include tax

m [ Process credit card payment when saving

[(saverciose | [_saveanew ][ clear ]

Deposit To Undeposited Funds v/ |
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Money In | Receiving a Payment

Receiving a Payment

When you receive money from a customer, you must receive the
payment in Reckon Accounts so Reckon Accounts can record the
transaction and mark the invoice as being paid. When you receive
a payment, the accounts receivable records are updated, and the
payment is ready to be deposited into an account.

To receive a payment:

A Go to the Customers menu and click Receive Payments.

B Fill in the top portion of the form, including the customer’s name,
the payment amount, payment method, and the date on which the
payment was received.

C Check the column to the left of the invoice to which you want to
apply the payment. You might be asked to decide how to apply the
payment for one of the following scenarios:

Overpayment can become a credit or refund
Underpayment can be left as is or written off
Customer has unused credit to be applied
Customer has available discounts

Money In

Did You Know?

Sales Receipt

A sales receipt is the form you use when you
make a sale for which you receive full payment
at the time of the sale. Sales receipts can
include payments by cash, cheque, or credit
card.

Did you know?

You can also use a sales receipt to create a
summary of sales income and tax owed. You
can summarise daily or weekly sales on a sales
receipt.
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Choose the appropriate selection and you should see your choices reflected in total amounts for selected

invoices.

If the customer has a discount or available credits, you can choose how to apply them.

Save the payment.

Choose a customer from the
drop-down list.

Customer Payment
Received From Handy Bulders | Customer Balance 14.154.50 o
642,50 Date |15/12/2009 [H) d fa

The checkmark next to the
invoice tells Reckon Accounts

to apply the payment to this
invoice.

€ Receive Payments Type a help question v How Do n-@

Derevious BPnext R History ~ [] Journal

et paid faster.
Accept credt cards
Pmt. Method [Cheque v Cheque#  [2112 @ berks
Memo. Depositto |UndeposkedFunds || o more
% Find 3 Ct
65 Y
v 1511272009 66 642,50 [25/12/2009 642.50 642.50
v
Totals 14,906.50 14,154.50 64250 |
Amounts for Selected Invoices
Amount Due 642,50
Apphed 64250
Ces Credks Applied 0.00

Save &Close Save & New Clear



Money In | Making a Deposit

Payments to Deposit Type a help question

Select View =
View payment method type | All types v | What are payment method views?
Select Payments to Deposit
/  Date Time Type No. Payment Met... Name Amount
12/10§2007 RCPT 70 Cash Andrew Rebak 330,00
10/01/2008 RCPT 69 Cash Zeus Construction 7.00
( _ _ 10/12/2007 PMT 45878 Cheque Zeus Construction 15,000,00
The checkmark indicates 20122007 PMT 01254 Cheque Zeus Construction 316,25
. . 30012009 PMT 2112 Ch And Rebak $22.50
which payments to deposit. _e — e e 522,504
~
Reckon Accounts sorts received
payments by payment method
type.
1 of 5 payments selected for deposit Payments Subtotal 522.50
[ OK ] [ Cancel ] [ Help J
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Click Payments to see other W Werevious [P Next HPrint ~ ‘Paymelnts @ History (] Journal
payments you can depOSIt. J pr— = = pr—
Deposit To v | Date [30/01/2009 [E] Memo |Deposit
Click Payments to seledt customer payments that you have received. List any other amounts to deposit below.
Indicates the account to RecetvedFron From Account Memo ChkNo.  Pmt Meth, Class. Amount |
which you want to deposit Andrew Rebak L und: 2112 Cheque 522,50 A
the funds.
24
Deposit Subtotal 522,50
To get cash back from this deposit, enter the amount below. Indicate the account
where you want this money to go, such as your Petty Cash account.
Record cash back from a Cash back goes o Cash backmemo Cash back amount
deposit by specifying the — | I | ~
account and amount here. Deesic 52250
[(savescClose | [ savesnew | [ clear |
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Making a Deposit

When you receive a payment from a customer, you can either deposit
the payment into a bank account immediately, or you can wait until a
later time to make the deposit.

To make a deposit:

A Go to the Banking menu and click Make Deposits.

B In the Payments to Deposit window, select the payments that you
want to deposit and click OK.

C In the Make Deposits window, click the Deposit To drop-down arrow
and then click the account to which you want to deposit the funds.

D Verify the date and the list of payments to deposit, making updates
as necessary.

E If you want to receive cash back from this deposit, fill in the Cash
Back fields at the bottom of the form.

F If you want to print a deposit slip or deposit summary, click Print.
G Save the deposit.
Note: Just because you've recorded the deposit in Reckon Accounts doesn’t

mean that you’ve actually made the deposit and that the money is available. You
still need to physically deposit the money at the bank.

Money In

Key Term

You can set a preference so that payments
received:

¢ Automatically go to the undeposited funds
account

* Automatically get calculated and applied as
you select invoices in the list

Go to the Edit menu, click Preferences, and then
click the Company Preferences tab in the Sales
& Customers area to set this preference.
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Money Out | Paying Bills

Paying Bills

As you purchase equipment, supplies, products, or services to run your business, you will also receive bills that
need to be paid. Entering these bills in Reckon Accounts enables you to not only track information about your
purchases, but also to pay these bills. Reckon Accounts remembers all of your unpaid bills, enabling you to easily
choose the bills you want to pay. Reckon Accounts then writes and saves the cheques or credit card charges or
sends the online banking payment instructions, depending on the payment method you choose.

Note: Before paying a bill, be sure you read the section “Writing cheques versus paying bills” to make sure you are using the correct
payment method.

To enter a bill:
A Go to the Suppliers menu and click Enter Bills.

B In the Supplier field, choose or enter a new supplier.

Note: If an open purchase order exists for this supplier, you are prompted to receive against it. Click Yes to receive against one
or more purchase orders; then, in the Open Purchase Orders window, click each purchase order that contains items you've
received and are being billed for.

C In the Amount Due field, enter the amount of the bill.

D Fill in the Date, Ref. No., Terms, and Memo fields as necessary.



E For expenses (money you spend to run your business, such as
utilities), assign the invoice to one or more expense accounts on
the Expenses tab.

For items (products or services your business buys), edit items that
were entered from your purchase order or enter new items on the
Items tab.

F  Click Save & Close or Save & New to save the transaction.

To pay a bill:

A Go to the Suppliers menu and click Pay Bills.

B All outstanding bills are displayed. To limit the number of bills
displayed, click Due on or before and then click the due date for the
bills you want to display.

C Specify the Payment Account, Payment Method, and Payment Date.

D Click Pay Selected Bills to complete the transaction.

Money Out

Did You Know?

Do not use the Write Cheques window to write a
payroll payment, pay your payroll liabilities, pay
tax, or pay bills you've already entered in the Pay
Bills window.

Refer to the in-product Help for more information
on how to make these types of payments.

Paying employees

Refer to page 122 for instructions on paying
employees.

Paying bills

You don’t need to use the Pay Bills window to
pay your bills. You can enter cheques, credit
card payments, and cash expenditures directly in
the appropriate account register. However, if you
enter bills using either the Enter Bills window or
the Accounts Payable register, you must use the
Pay Bills window for your bill payment. Do not
use the Write Cheques window to pay a bill that
you've entered with either of these methods.
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p
Choose or enter the name
of the supplier who sent you

the bill.
, ¥

g
Select the payment terms
here and Reckon Accounts
will autofill the Bill Due

L date for you.

J

[Enter the amount due here. ]—e

Assign the bill to one or more

‘B Enter Bills vaahabmvmnon (X\
Dprevious (P Next € Find %y History ] Journal
@8l Ocregr [“]8il Received
__________sn_____________________ |
Sup... Gallon Masonry v Date 30/0172009 [
miﬁm-uw Ref. No.
189 Old Bayshore Road :
Sydney, NSW 2000 AmountDue  1,550.00
o 2ty (8)
Terms  Net30 v Discount Date
Memo
—_—
Expenses $1,550.00 | Items sn.w}
Account Tax. Gross Amt___TaxAmt___Memo Customer:Job____ Bila... Class |
[Equipment Rental  NCG [ 1550.00] 14091 I
9
Supgler TaxCode | v TotalTaxes| 14051
ts include tax
Save &Close | [ Save &New [L]

expense accounts.

’_&M




Select Bills to be Paid

Hiswids (") Due on or before 25;12}2024

sty poveterer | o]

[7  Date Due Supplier Ref. Mo. Amt. Due Credits Used Amt. To Pay |
[T |30/10/2023 |ReckonLtd 230,95 0.00 0.00 =
[T |o1/12/2023 |Australian Insur... 5,000,00 0.00 0.00 [
[T |o5/12/2023 |QABC Biz 560.00 0.00 0.00
[T |o5/12/2023 |The Colour Cap... 652,00 0.00 0.00
[T |08/12/2023 |MH Trucks 5,000,00 0.00 0.00
[ |08/12/2023 |OzDoors 15,840.00 0.00 0.00 -
Totals  1,254,092.31 0.00 0.00
Credit Information for Highlighted Bl
Supplier Number of Credits 1}
Eill Ref, Ma. Total Credits Available 0.00
GotoBil | Set Credits |
Payment Account Payment Method Payment Date
To be printed
ABC Bank v [cheqe @ Tobepin=d
Ending Balance 71.244 23 () Assign cheque #
| Pay Selected Bills | [ Cancel
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Money Out | Writing Cheques

E Write Cheques - ABC Bank Type & help question [ask [~ How Do 17] X
Indicates the account from Dereviows Bhext Gt - B Find ] Joumal
which the funds will be taken BarkAccout [apCoank | Endng Balance 2714044
for this cheque. o %
Date 14/07/2009
. b $ 1,500.00
[Fill out the cheque just like One thoussnd five bundred dolors snd Deanta™ * *# S T e s e R R suArT RS
N 189 Old Bayshore Road
you would a paper cheque e Eayhore
< =
Use the Expenses tab to e
itemise purchases you make |—@)—f— fwenses 150000 | nens 00 [Cashicheaue v
& 1Job_ Billa... Class
to run your business, such as AT M T e T T v

job materials or utility costs. [E]

Use the Items tab to itemise _e
the products and services
you’ve bought with or without Suppler TaCode | v|  [Z]Amountsinclude tax TotalTaxes[0.00 |
a purchase order.

(aveaone ) (oomaton J(cewr ]

Select Cheques to Print

Select Cheques to Print Type a help question ¥ How Do 12 X

Make sure that the cheques in| ey 5 First Cheque @ & order
your printer correspond to the
Select cheques to print, then click OK.
cheque number entered here. There are 26 Cheques to print For $74,213.60.
4 Date Payee Amount l OK l
5 15/11/2003 Taubmans and Sons Tra... 2,211.50 A
- Fon oo i
Click here to choose the | Ay i ol
cheques you want to print. v Georgian Plywood Impor. 5,000.00
5 |Georgian Plywood Impor. 2,000.00
Rajah Furniture 1,500.00
7 Srith Designs 1,725.00 Select Al
v [Homeware House Items 1,905.25 —
V |14/07{2009 Gallon Masonry 10,450.00 ¥ Select None
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Money Out

Writing Cheques Did You Know?

You can write a cheque for any kind of expense that you track with
Reckon Accounts expense accounts and for non-inventory part, service,

You should not use the Write Cheques window
to write a payroll payment, pay your payroll

and other charge items. If you are using inventory or purchase orders, liabilities, pay tax, or pay bills you've already
you can write cheques for inventory part items too. entered in the Pay Bills window.
Note: Before writing a cheque, be sure you read the section “Writing cheques Paying employees

versus paying bills” to make sure you are using the correct payment method. Refer to page 122 for instructions on paying

. employees.
To write a cheque:

A Go to the Banking menu and click Write Cheques.

B Click the Bank Account drop-down arrow and then click the account
from which you want to write the cheque.

C Fill in the onscreen cheque as you would a paper cheque.

D Itemise your expenses (shipping charges, taxes, or other expenses
not associated with any one item) on the Expenses tab.

E If you are purchasing items for your stock, enter the items on the
Items tab.

F  Save the transaction.

To find and print a single cheque:

A Load the blank cheque form into the printer.

B Go to the Banking menu and click Write Cheques.

C Click the Find button and search for the cheque you want to print.
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D Double-click to view the cheque you want to print.
E Click Print.

F In the Print Cheques window, choose the options you want and click Print.

Note: To learn how to print multiple cheques at the same time, refer to the in-product Help.
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Money Out | Issuing Credits or Refunds

Adjustment Note

@ Create Adjustment Notes/Refunds - Accounts Receivable

Select the template you
want to use, or create your
own.

-

Enter the name of the S I e —

returned item here.
™

-
Describe the reason for the
return.

-

Choose to print or email a
copy for the customer.

N
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Issuing Credits or Refunds

Use an adjustment note to record a credit when a customer returns items and you've already recorded an invoice,
customer payment, or sales receipt. You can also use an adjustment note for an overpayment.

To enter an adjustment note or record a return:

A
B

Go to the Customers menu and click Create Adjustment Notes/Refunds.

In the Customer:Job field, click the customer and job for which you are creating the adjustment note or refund
cheque.

Note: If you have created more than one job for the customer, be sure to assign the adjustment note to the correct job. You can
apply the adjustment note only to the same job for which it was created.

Click the Template drop-down arrow and then click a template.
Enter the items being returned in the line item area.
Describe the reason for the adjustment and enter the quantity and rate, if applicable.

(Optional) Enter a memo for this transaction.

Note: The memo does not print on the adjustment note, but it does appear in the Accounts Receivable register and in the
customer register.

Indicate whether you want to print or email the adjustment note to the customer.

Save the adjustment note.



In the Available Credit window, choose how to use the credit. You
can:

¢ Retain as an available credit
e Give a refund
* Apply it to a tax invoice

Note: Reckon Accounts enters a negative amount in your Accounts
Receivable register for the adjustment note.

Money Out

Did You Know?

Adjustment note

A document that notifies a customer that you
have reduced the customer’s balance (for
example, when a customer cancels a sale,
returns something, or overpays).
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payroll payments in this bank
account.

f & N\
Reckon Accounts records the

7
Specify a pay period and

payment date for the payroll

payments you create.

p

Reckon Accounts creates a
payroll payment for each
ticked employee.

2
Review payroll payments and
enter hours worked, personal
leave or holiday time,
commissions, or other
variations from pay period to
pay period by clicking the

employee’s name.
.

Money Out | Paying Employees

Enter Hours and Select Employees to Pay

Il Information




("Choose whether payroll
payments should be printed
from Reckon Accounts or

written later by hand.
N\

( Review payroll payments and
enter hours worked, personal
leave or holiday time,
commissions, or other
variations from pay period to
pay period by clicking the

L employee’s name.

Money Out

Review and Create Payroll Payments

EEE30
vz (8]
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Paying Employees

Your employees can be paid weekly, fortnightly, half monthly, monthly, or four weekly, and you can create their
payments using cash, cheques or direct deposit. The employee’s tax is calculated automatically using the tax code
that you entered in the employee’s profile.

Note: Before you begin paying your employees, ensure that your payroll is set up completely and correctly in Reckon Accounts.

The following steps create payments for unscheduled payroll. If you want to use payroll schedules, see the sidebar
to the right.

To create payroll payments:

A

m O N @

Click the Payroll Centre icon.

In the Payroll Centre, click the Pay Employees button.

Select the employee or employees you're creating the payroll payment for.
Verify that the Payment Date and Pay Period Ends date are correct.

Click the Bank Account drop-down arrow to choose the account that Reckon Accounts uses to record this
transaction.

Click each employee’s name to open the Review or Change Payroll payment window by clicking Open Paycheque
Detail. Make any necessary changes and click Done.

Click Continue.
Review the payroll payment information in the Review and Create Payroll Payments window.
Click Continue.

Click Create Payment.



K In the Confirmation and Next Steps window that appears, click Print
Cheques or Print Payslips, or both.

L  After printing your payroll payments or payslips, click Close.

Money Out

Did You Know?

Using Payroll Schedules

A payroll schedule defines when you should run
your payroll so that you can pay employees on
their pay day. You can use payroll schedules

to group together employees in whichever way
makes the most sense for you to your business.
However, all employees grouped in the same
payroll schedule must have the same pay
frequency (weekly, fortnightly, monthly, and so
on).

If you want to use payroll schedules, click the
Payroll Centre icon. From the Pay Employees
section, click Set Up Your Payroll Schedule.
After you create a new payroll schedule, you can
assign employees to it.

To run a scheduled payroll, go to the Employees
menu, click Pay Employees, and then click
Scheduled Payroll. In the Pay Employees section,
click to select the payroll schedule you want to
run and then click Start Scheduled Payroll.

For more information, see the in-product Help.
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Managing Your Business | Using Reports
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Report choices displayed in
the window are based on the
category you choose.

Click the thumbnail report
icon to view a sample of
a report.

Click More... for details
about content, dates, and
customisation.

¢

Reports |
o & Financiel Customers & Receivables
By Find out how much money your customers owe and when it is due.
0
|Receivables  pn Aging (what my customers owe me and what is overdue)
iSeles 6 sunmery wef
Jobs, Time & Mileage overdue? More.. E
Tpplers =3 ) Detail More
s . my customers, what propartion of that amountis
es AR Aging Detail aph of the information in the A/R aging summary
Ty Tpe _owe tame Tums Dueows Buwee
Employsss & Payroll e 1m0 ono 30| chrgs hveitbeen peid andwhen e hey
Banking b N ) L
Ivios 110172000 Pt Etes N30 120100 605 o

Accountent& Texes Tl

m
Budgets & Forecasts lovcice  08/D1/2000 Pretel Estates Net 30 08172000 __060.00
= Taat> %0 woo

o 18335 |ner owe? More.

s make up each customer's current
B4 2 (e
a by Vore.
Customer ]

View detailed Help topics to
learn how to use and modify
reports.




Using Reports to see how your business is doing

One of Reckon Accounts’ most robust features is its ability to generate
data-rich reports about your business. Everything you enter in Reckon
Accounts can be found and generated into a report.

Reckon Accounts comes with dozens of prepared reports that you can
run. You can use the Report Centre to learn about Reckon Accounts
reports and locate the ones that contain the information you need.
Once you've found a report, you can change its date range, customise
the way it looks, print a copy of it, export it to Microsoft Excel, or
display it on your screen.

To find and display the right report:

A Click the Report Centre icon at the top of the Reckon Accounts
window.

B Click a report category from the list on the left. Reports for the
selected category are displayed on the right.

C From the report list, you can view a thumbnail picture of the report
by moving your mouse over the thumbnail icon @. To learn more
about a specific report, click the More link. The in-product Help
window opens with information about the data and specific ways to
customise the report.

Managing Your Business

The Report Centre includes its own Learning
Centre, where you can find detailed information
about how to run, modify, and manage reports.
You can view the Report Centre Learning Centre
by clicking the Learning Centre link in the top-
right corner of the Report Centre.
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D When you find the report you need, click its name to view the report.

Tip: In addition to the powerful reports available in the Report Centre, you can also use the Reckon Accounts Centres to
get a quick snapshot of how your business is doing and the status of your relationships with your customers, suppliers, and
employees. For example, from the Centres you can easily see all of your unpaid bills, all of the invoices that your customers
haven'’t paid, and the detailed history of each of your customers and suppliers. For more information about the Reckon

Accounts Centres, refer to “Reckon Accounts Centres” in the in-product Help.

How to Use Reports to Find the Information You Want

The Reckon Accounts Report Centre describes all the available reports. Here are 10 common questions that people

ask and the Reckon Accounts report you can use to find the answer.

Item Type Purpose

How much money did my company make or lose over a specific period of time?

Profit & Loss Standard
(In Company & Financial)

Which invoices or statement charges haven’t been paid and when are they due?

Open Invoices
(In Customers &
Receivables)

How much does my company owe each supplier and are any payments overdue?

Unpaid Bills Detail
(In Suppliers & Payables)

What is the value of my company (its assets, liabilities, and equity), and where can | see the
total balance for each type of account?

Balance Sheets
(In Company & Financial)




Managing Your Business

Item Type Purpose

What is the recent activity in all my company’s accounts, with beginning and ending balances General Ledger
for each account? (In Accountant & Taxes)

Sales by Customer Summary

What are the total sales for each customer and job?
(In Sales)

Sales by Iltem Summary

L . N . -
Which items and/or services bring in the most/least income? (In Sales)

Expenses by Supplier
What are my company’s total expenses for each supplier? Summary
(In Company & Financial)

Income Tax Summary
Where is the information | need for my income tax forms? Income Tax Detail
(In Accountant & Taxes)

For my company’s total sales, how much is taxable, at what rate, and how much tax is Tax Liability
currently due to be paid? (In Suppliers & Payables)
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Memorising a report for reuse

Whenever you change the settings for a report (modify it), you can memorise the report with the new settings and
save it in the Memorised Report List. Then, when you want to create a similar report, you can click the Memorised
Report List to find it.

Note: Reckon Accounts memorises the report settings, not the data in the report. When you display a memorised report, it applies
the settings you memorised, but displays the latest data. For example, if the report date is set for the period Last Month and you
memorise the report in September but recall it in December, the recalled report will have data for November, not August.

To memorise a report:

A Click the Report Centre icon at the top of the Reckon Accounts window.

B Open the report you want to modify and save.

C After you have customised a report, click Memorise at the top of the report.
D

If you have changed an existing memorised report, indicate whether you want Reckon Accounts to replace the
earlier report (under the same name) or create a new memorised report (under a new name).

m

In the Memorise Report window, enter a title for the report.

F If you want to assign the report to a memorised report group, choose Save in Memorised Report Group and
choose the group from the drop-down list. (You must already have the group set up on your Memorised Report
List. You cannot create a new group here.)

G Click OK.



Managing Your Business

Tip: When you create a report, you can change the way it looks (reformat it). You can change the fonts, change the header and
footer, and resize the columns.

You can also move and sort the data that the report contains. For example, you can add or delete columns, sort by columns,
move columns, change how numbers display, change how transactions sort, and change the subtotal groupings.

For more information about how to modify the look and content for a report, refer to the in-product Help.

Other add-ons to help you manage your business

Reckon’s add-ons enable you to streamline management of your business and automate essential business

activities. They offer easy-to-use, tightly integrated solutions that will enable you to manage your business efficiently
and with confidence.

They include:

e Super Data

e Stationery

e Credit Card Payments

To learn more about these business solutions, visit the Products and Services areas of our website at
www.reckon.com
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What's New In Reckon Accounts

This chapter highlights some of the changes in this version of Reckon Accounts. For more information about any of
these features, refer to the in-product Help.

This release of Reckon Accounts includes the following new features and improvements.

Deductions (Union Fees, etc.) Tax Tracking Type renamed to Deductions (Union

Fees) - Australian version only

As per ATO’s requirement, Deductions (Union Fees, etc.) Tax Tracking Type has been renamed to Deductions (Union
Fees) and only Union fees transactions should be used for this. Payment Summary will also show the name of the
organisation and the amount withheld.

“OVERDUE” stamp on Invoices

Invoices which are overdue will now show “OVERDUE” stamp when viewed on screen, printed or emailed.

“CLEARED” stamp on reconciled Credit Card transactions
Reconciled Credit Card transactions will now show “CLEARED” stamp when viewed on screen.



New Features

Employee humber is now unique and mandatory

As per ATO’s STP requirement, employee number has to be unique and mandatory. When you create a new employee
or edit an employee’s record, you will be asked to enter a unique employee number.

“Previous” button on Review/Change Payments screen

You can now view the previous paycheque detail of an employee during your pay run when there are more than 1
employee. Due to this change, keyboard shortcut P (ALT+P), which was used for Pay period previously, is how used for
Previous button and Pay period now uses Y (ALT+Y).

Sort Pay Bills screen by Ref. No.

You can now sort your bills by Ref. No. when paying your bills in Reckon Accounts.

“Send Forms” window is now resizable
You can now re-size Send Forms window.
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New Zealand Payday filing and Payroll Update - New Zealand version only

From 1 April 2019, Payday filing will be compulsory for all employers in New Zealand. New Zeland employer
paying more than $50,000 PAYE and Employer Superannuation Contribution Tax (ESCT) per year, will need to file
electronically.

In the 2019 financial year the New Zealand government has increased the ACC maximum threshold from $126,286
to $128,470 for the 2019/20 financial year. The Student Loan Annual Threshold has also increased from $19,448
to $19,760.

Reckon Accounts New Zealand has been updated to include Payday filing capability, including exporting New/
Departed

Employees. You can export these files and import into IR Portal.
Reckon Accounts includes the latest PAYE and ACC rates.

Reckon Tools Online Backup and Reckon GovConnect are no longer available from Reckon Accounts 2019.
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Contacting Reckon

If you can’t solve a problem you're experiencing with Reckon Accounts, you can get help by telephone, fax or email.
Reckon also provides a website, (https://www.reckon.com/au/support/), which includes a database of support
articles (Knowledge Browser) as well as contacts for Reckon Accredited Partners.

Fee based services

Reckon offers a number of support plans to meet your individual needs.

* Timed Call Support: A one-off support call that is charged by the minute. For instant help during business hours,
ring our telephone support service for the advice you need.

* Data Recovery: If your Reckon Accounts data file becomes damaged, we can provide data recovery service, which
is available for a fee.

e Password removal: If you forget your Administrator password, we can remove your password So you can access
your important data, a service that is also available for a fee.

Reckon Advantage

Reckon Advantage membership entitles you to free weekday technical and installation phone support, product

upgrades and special offers. Terms and conditions apply. For more information, visit www.reckon.com/support.

Reckon's Accounts website

The Reckon Accounts website, (www.reckon.com), is the official site for Reckon Accounts users. You can get
answers to many Reckon Accounts questions, important updates, and access to help through it. If you have an
Internet connection, you can access the Reckon Accounts website directly from the Help menu in Reckon Accounts.



Contacting Reckon

Reckon Accredited Partners

Developing a strong, knowledgeable network of professionals is an important part of our commitment to delivering
exceptional support to our Reckon Accounts customers. Whatever your individual needs, Reckon has an expert to
help.

The Reckon Accredited Partners referral service is free. The professional you select will provide you with information
about their fees.

If you are an accountant, bookkeeper, or computer consultant, consider becoming a member of this unique
community. To find a Reckon Accredited Partner, or to become one yourself, visit the Reckon website. Details for
contacting Reckon Australia are provided below.

Talking to a technical support representative
Be prepared when you call
If you need to call for assistance, you will get an answer quicker if you:

* Make sure you have registered your copy of Reckon Accounts and have your registration number and customer
ID number ready. (It's a good idea to have written this down in the front of this guide following registration.) To
display your registration number, go to the Help menu and click My Licence Information.

* Are at your computer with Reckon Accounts installed.

* Try to remember the windows you opened and the tasks you did before encountering the problem. Know the
exact wording of any message that appeared on the screen.

e Have your company file set up for multiple users who have access to different areas of Reckon Accounts, as
you’ll need to have access to most of the software. You might also want to switch to single-user mode.

* Have a pencil and paper handy to take notes.
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Have the following information ready when you call:

* Model of computer and amount of memory (RAM) and hard disk space

e Accessory manufacturer, type and model (for example, monitor or printer)
e Operating system version

* Network configuration and software version

Solving problems on your own

Note: We recommend you back up your data before you start solving your problems. For more information, see the in-product Help.

Guidelines for solving typical problems

Use the following examples as a guide to solve the problems you have.

Try the procedure again

Start at the beginning. Examine windows where you filled in fields to be sure you are asking the program for what
you want.

For example, if invoices you just entered are not showing on your Profit and Loss statement, you should ask
questions such as:

Does the date of the report include those invoices?
Do the invoices appear if you change the report from cash to accrual basis?
Does this problem occur with only invoices for one particular customer?

Have you changed any filters on the report? (Try to create a new report from scratch to see if the problem is
solved.)



Contacting Reckon

Try a related procedure

For example, if you have a printing problem:

Ensure the printer is working by trying to print something else. If you have trouble printing cheques, try printing a
report. If you can’t print one of the sales forms, try printing a similar form.

If you can’t print from Reckon Accounts, try printing from another program such as Microsoft Notepad. If
nothing prints from Notepad, you know the problem is related to the printer, not the software. Check the printer
connections, printer driver, print queue and so forth.

Think about what has been changed

If something used to work but no longer does, think about what changed.

Have you changed or added other programs on your computer?

Have you added a new printer?

Have you moved the Reckon Accounts company file to a new location?
Have you changed a setting in the Preferences window?

If the program “hangs” or locks up

There are a number of reasons why your system may freeze while using Reckon Accounts. Try restarting your
computer. If restarting doesn’t help, go through the following list of questions and take any related action:

Does your computer system or network meet the minimum requirements necessary for Reckon Accounts? (See
“System requirements” on page 7).

Are you making the best use of available system resources by shutting down other programs that are running?
(Check for programs that may be running in the background without your knowledge.)

Do you have enough hard disk space available? (This is a common problem for those working in a multi-user,
peer-to-peer network situation.)
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* Do you have any conflicts with sound or video drivers?

Note: If you encounter system freezes while using Reckon Accounts, you may want to call for technical support.

Reckon Contacts

Product Activation

Products can be registered online
24 hours a day or by telephone.

If you can't activate your product
using onscreen instructions after
going to the File menu and then
clicking Activate ReckonAccounts,
call:

1 800 732 566

Product Reactivation

You can reactivate your program
through this service.

Reactivation is a service that

attracts a small per-minute charge.

(Charges include GST and only
apply once you are connected to a
representative.)

Call:
1 800 732 566




Customer Service and Reckon Sales

Contacting Reckon

For pre-sale, product-specific
information, to purchase an
upgrade, for order inquiries, or
information on Reckon Advantage
and so on.

Call:
1800 732 566

Email:
customerservice@reckon.com

General Product Information

For general product information and
FAQs.

Visit:
http://www.reckon.com.

Technical Support

Call cost $4.90/min

(Charges include GST and

only commence once you are
connected to a technical support
representative.) Charges are
higher from public and mobile
phones.

Search the Knowledge Browser for
answers to common questions.

Call:
1902 223 101

Call costs subject to change. See
https://www.reckon.com/au/
support/ for available hours.

Visit:
https://www.reckon.com/au/
support/
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Australia

Training

Reckon Training provides classroom training
to assist you in getting the most from your
software.

Or you can visit a Reckon accredited trainer near
you. The Reckon website provides a list of all
the Reckon accredited trainers.

Call:
1300 655 975

Data Recovery

To request data recovery for a damaged Reckon
Accounts file.

For more information on data recovery online.

Call:
1800 732 566

Password Removal

To request a forgotten password be removed
from your file.

Call:
1800 732 566

Reckon stationery

Reckon offers a range of stationery that works
with your Reckon software. Cheques, invoices,
pay slips and more — Stationery helps deliver the
most from your accounting software!

Call:
1300 301 166

Fax:
1300 131 972

Update your details

Keep your details current so we can keep you up
to date on product developments and important
software changes.

Update your details online at http://
http://members.reckon.com/Login.
aspx




Contacting Reckon

Postal address Reckon postal address to send software orders Reckon Software
as well as any other written correspondence. Locked Bag 7522
McMahons Point NSW 2060

Web address www.reckon.com
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New Zealand

Product Registration

Call:
0800 933 606 (from within New Zealand)
+64 9 489 9440 (from abroad)

Customer Service

Call:
0800 414 3650

Email:
sales@reckon.co.nz
Visit:
www.reckon.com/nz

Technical Support

Call:

0800 933 666 (attracts small charge per incident)
Charges are higher from public and mobile phones.
Visit:

www.reckon.com/nz
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Reckon Accounts
Licence Agreement

THIS IS AN IMPORTANT DOCUMENT. PLEASE READ IT CAREFULLY.

This is a contract between Reckon Limited (ACN 003 348 730) (Reckon) and you. By using the Software supplied
with this document, and the related user guides and materials (together the Software), you agree to be bound by the
terms of this Licence and the application of Reckon’s Privacy Policy to information collected from you. The Privacy
Policy can also be viewed on the website.

This Licence covers copies of the Software provided for evaluation or trial purposes, subscription versions and non-
subscription or full versions of the Software. Some Licence provisions may not be applicable to you, depending on
the particular version of the Software you have purchased or if you are using the Software for evaluation purposes.
The defined terms and the rules of interpretation in this Licence are set out in clause 14.

Important: Please refer to the website for details of the Software, minimum requirements and functionality. Please
also refer to Reckon’s Privacy Policy at www.reckon.com.

There are a number of technical features within the Software that may affect your ability to continue to use the
Software. These are outlined in more detail in the terms of the Licence, but in summary:

» You are purchasing the right to use the Software, not to own it;

+ If you have been provided with a Trial Version, you may only use the Software on a temporary basis to evaluate
the Software’s functionality and suitability for your requirements;

« The Software contains registration and activation processes to guard against illegal copying;
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To continue using the Software, those processes require you to verify your compliance with the terms under
which you are licensed to use the software (for example: the number of computers on which the software is
installed) and to permit continued reactivation of the Software from time to time. This involves, in all versions,
periodically verifying your licence details, and in the subscription version, renewing your subscription when it
falls due. Reckon may also verify subscription customers during a subscription period and not only at renewal.
You will also need to reactivate your Software if you want to reinstall it (for example, if you upgrade your
computer or if you have a hard drive failure, and you may incur a technical support cost for this);

When you purchase the Software or during the course of your subscription you will be provided with an
installation key code (“IKC”) for your exclusive use in accordance with the terms of this licence. Please keep
the installation key code in a safe place. You may need it when you first install or re-install (if permitted) the
Software and to reactivate the Software. Please note if you lose your installation key code that it will not be
replaced by Reckon and you will not be able to install or reactivate the Software;

You also need a licence key to reactivate your Software. In addition, with some older versions of the Software,
you will not be able to re-install or reactivate the Software if you do not have your installation key code - see
details below on Reckon’s sunset policy;

There will be no charge to activate the Software initially or to reactivate your Software when you verify your
licence details or renew a subscription. Reckon may charge you a fee for technical support if it needs to
reissue a licence key provided also that the version of the Software you are using has not been ‘sunsetted’ as
explained below. Reckon may also charge a fee if you need to reactivate the Software in other circumstances
(for example, if you need to reinstall the Software if you upgrade your computer or due to a hard drive failure);

If you do not renew your subscription, which also requires you to install and use the updated Software or if
you do not verify your licence details (as applicable) within the required period, the Software may continue to
operate but with impaired functionality or you may not be able to access the Software at all (including printing
out or viewing any of your data or records); and
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Reckon has a ‘sunset policy’ which means that technical support is not available for some older versions of
the Software. This includes the ability to install or re-install that Software for any reason if you have lost your
installation key code for those old versions. If you wish to continue using the Software in those circumstances,
you will need to purchase a new copy of the current version of that Software.

Data Collection & Privacy: You acknowledge that Reckon collects information from you when registering,
activating and validating the Software and when you use the Software. For details on how we collect, use,
disclose and store your personal information and how you can contact us if you want to access or correct
personal information, please refer to Reckon’s Privacy Policy on our website www.reckon.com. By activating
and using the Software you consent to Reckon’s collection and use of the information collected from you in
accordance with Reckon’s Privacy Policy.

Reckon BankData: You must have a current subscription to Reckon Accounts software (excluding EasyStart)

or as specified on the Website, which may be updated from time to time. You will require internet access. Your
access to the bank data feeds are subject to your bank’s terms and conditions and their acceptance of your
application to supply the bank data feeds. This Licence will entitle you to the number of bank data feed import
transactions for you which you have subscribed and paid. This licence is not transferable between other Reckon
products (eg. Reckon One). You must purchase a separate licence for each other Reckon product in which you
want to import bank data feeds

Use of Software is not provision of professional advice:

(@) The information contained in the Software may contain features designed to assist you in complying with the
requirements of relevant legislation.

(b) In providing you with information which may relate to relevant legislation, Reckon is not engaged in rendering
legal, accounting or other professional services and that nothing in the Software constitutes taxation,
financial, wealth management, superannuation or other professional advice. Legal, accounting or other
relevant professional advice should be obtained before taking any action in reliance on this Software.
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(c) While relevant reports produced using the Software will be compliant with legal requirements at time of
release, as these requirements may change from time to time, you should confirm compliance with your
professional adviser before relying on any such reports.

(d) The help contained in this Software is not a substitute for obtaining the appropriate independent professional
advice. If legal advice or other expert assistance is required, you should seek the service of the appropriate
competent professional.

Third Party Online Services: The Services may contain access to, or features that interface with, third party
online services (“Third Party Online Services”), such as bank data feeds. Where Third Party Online Services

are available, separate terms and conditions with the provider of the Third Party Online Services may apply and
access to the Third Party Online Services may be terminated if you do not pay the required charges. Charges
may apply for the use of Third Party Online Services including the cost of internet access. Except as required

by the Consumer Guarantees, access to Third Party Online Services may be withdrawn by Reckon at any time.
Reckon does not make any recommendations in relation to the Third Party Online Services or accept any liability
or responsibility for any loss or damage relating to the Third Party Online Services except as required by the
Consumer Guarantees.

Back up & Data Retention: You should ensure you conduct regular backups of your data. Except as required by
the Consumer Guarantees, Reckon on behalf of itself and/or any of its distributors and associates, does not
assume any liability with regard to your use of the Software, including but not limited to, loss of data. In addition,
you should confirm your data retention requirements for tax and compliance purposes with your professional
adviser.

Liability: To the maximum extent permitted by any law, including the Competition and Consumer Act 2010 (Cth),
Reckon will not be liable responsible for delays, non-performance, failure to perform, processing errors nor will
the liability of Reckon include or extend to any special or consequential loss or damage suffered by you, except
where required by the Consumer Guarantees.
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- Limitation of implied terms: In relation to goods or services not ordinarily acquired for personal, domestic or household
use, Reckon’s (and its distributors’) liability for breach of any guarantees, implied conditions or warranties that cannot
be excluded is limited, to the extent permitted by law and at the option of Reckon, to repair the goods, or the cost of
repairing the goods, to replacing or re-supplying the goods or services or their equivalent again or the payment of the cost
of having the goods or services or their equivalent replaced or supplied again. You acknowledge that this clause, and any
reliance on it by Reckon, is fair and reasonable.

* Reckon’s Contact details:
Business address: Level 2, 100 Pacific Highway, North Sydney, NSW 2060
Contact number: 1300 784 253

Contact email: customerservice@reckon.com.
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1. LICENCE

(a) Evaluation licence: If Reckon has provided a Trial Version of the Software to you, your rights to use the Trial
Version are solely as set out in clause 12.

(b) Licence to use: Reckon grants you a personal, non-exclusive, non-transferable, limited licence to use the
Software on the terms of this Licence for the period determined in accordance with clause 10.

(c) No transfer of copyright: The Software is licensed not sold, despite any reference to “purchase” or “sale” in
this Licence or in any invoice or purchase order for the supply of the Software. Reckon reserves all rights not
expressly granted to you. Reckon Limited is the owner of copyright in the Software and retains ownership of
the copyright and all other intellectual property rights in the Software and is protected by copyright law and
international copyright treaty.

(d) All access to the Software is solely verified by user Login and password;

(e) You are entirely responsible for maintaining the confidentiality of all your licence and access details (eg user
name and password) and every user of your Software including Third Party Online Services, such as bank
data feeds;

(f)  You agree only to grant access to the Software for use by you or on your behalf;

(8) You are entirely responsible for the access rights that are granted to any person or other users using your

Software, including Third Party Online Services.

You are entirely responsible for any and all activities using the Software by any person or persons, including
Third Party Online Services, such as bank data feeds;

151



152

2.

(i)

(1)

You are responsible for the accuracy of all information and authorisations provided to Reckon or any third
party service providers, relating to the Software or access to any of the Third Party Online Services, for
example bank data feeds;

Reckon will not be liable for any loss that you may incur as a result of unauthorised use of your Software or
any Third Party Online Services, by any person or persons;

You may be held responsible for losses incurred by Reckon or any third party due to any unauthorised use of
your Software or any Third Party Online Services, by any person or persons; and

Access to your Account may be restricted by user login and passwords.

YOUR PERMITTED USE OF THE SOFTWARE

(@)

(b)

(€

Single use licence: If you have purchased a single user licence, you:

(i) may install the Software once, on one computer only. However, if you wish to reinstall the Software (for
example, if you need to install the Software on a replacement computer), then clause 3 will apply; and

(i) must ensure that the Software is used by one person only at any one time.
Additional licences: Subject to any multi-user licence that you have obtained, if:
(i) more than one person is to use the Software at the same time; or

(if)y the Software is to be installed on more than one computer

then you must obtain an additional licence for each additional person or computer.

Premier Version
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(e)
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If you have purchased a full version of Accounts Premier, this Licence entitles you to load the Software on up
to two computers (for use by a single processing unit only on each computer) for use by up to two individuals
simultaneously. If you wish to install the Software on more than two computers you must purchase
additional licences that will permit up to five users to simultaneously access a data file. If Reckon releases
the next release of Accounts Premier while you are a member of the Reckon Advantage programme subject
to its terms and conditions, you will be permitted to make a total of five installations.

If you have purchased a subscription version of Accounts Premier, this licence entitles you to load the
Software on up to five computers (for use by a single processing unit only on each computer) for use by up
to five individuals simultaneously. If you wish to install the Software on more than five computers you must
purchase another full version or a subscription version of that software but for simultaneous access you will
need to upgrade to an appropriate version that permits more than five users to simultaneously access a
data file.

Accountant Edition

If you are an eligible Professional Partner who has purchased a full version of Accounts Accountant Edition,
this Licence entitles you to load the Software on up to five computers (for use by a single processing unit
only on each computer) for use by up to five individuals simultaneously. In some special cases with written
approval of Reckon only, certain Professional Partners may be allowed to load the Software on up to 25
computers. However, only 5 simultaneous users can have access to any single data file.

Enterprise Version

If you have purchased the Accounts Enterprise version of the Software, this Licence entitles you to load
the Software on up to ten computers with the option to load up to another 20 computers at the applicable
charge (for use by a single processing unit only on each computer) for use by up to ten or more individuals
up to a maximum of 30 (as permitted by the Licence purchased) simultaneously. You may not load the
Software onto any further computers.
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(h)

BankData

You may only subscribe to Reckon BankData if you have a current subscription of Reckon Accounts business
software (excluding EasyStart) or as specified on the Website, which may be updated from time to time.

You will require internet access. Your access to the bank data feeds are subject to your bank’s terms and
conditions and their acceptance of your application to supply the bank data feeds. This Licence will entitle
you to the number of bank data feed import transactions for you which you have subscribed and paid. This
licence is not transferable between other Reckon products (eg Reckon One). You must purchase a separate
licence for each other Reckon product in which you want to import bank data feeds.

General restrictions: You must not:
(i) use or rely upon the Software for any purpose or in any manner for which the Software is not warranted;

(ii) copy, reproduce, translate, adapt, vary, merge or modify or create any derivative work based on the
Software;

(iii) reverse engineer, decompile, disassemble, reconfigure or otherwise attempt to discover the source code
of the Software; or

(iv) sell, market, network, transfer, lease, license, sub-license, rent, lend, share or otherwise dispose of or
distribute the Software and/or the relevant unique installation key code (“IKC”); or

(v) use the Software to provide bureau, hosting or other services by internet or by any other means.

Licence verification: Upon written request from Reckon, including by e-mail, you agree to provide Reckon with
a signed certificate:

(iy verifying that the Software is being used fully in accordance with this Licence, including user and
machine limitations; and

(if) listing locations, types and serial numbers of equipment on which the Software is run.
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(i) Audit rights: Reckon may also audit the number of copies of the Software in use or possession by you,
the equipment on which the Software is installed or used and the number of users using the Software.
Audits will be conducted in your normal business hours, or upon reasonable prior written notice, at
Reckon’s expense. If the audit reveals underpaid or unpaid fees due to Reckon, you will be invoiced for
them based on Reckon'’s then current price list, and if these exceed 5% of the license fees you have
already paid, you will also be invoiced for the cost of the audit.

3. BACK-UP & DATA RETENTION

(a) Back up: You should also ensure you conduct regular backups of your data. Except as required by the
Consumer Guarantees, Reckon on behalf of itself and/or any of its distributors and associates does not
assume any liability for loss of data.

(b) Data retention: You are responsible for ensuring you meet all your data retention requirements for tax and
any other compliance purposes. You should confirm these requirements with your professional adviser, as

some legislation requires you to keep copies of certain data for later reference, for example, for the ATO or
ASIC.

4. PRODUCT ACTIVATION AND VERIFICATION
(a) Initial registration and verifying licence details: This Software may contain technology that protects Reckon
against illegal copying. As a consequence, you may be required to:

(i) register your details during the initial installation (including your name, contact details and details of the
hardware on which the Software will be installed (if this is not done automatically by the Software);

(ii) if you have a full version, have the Software reactivated periodically thereafter by verifying your licence
details to confirm you are using the Software in accordance with these Licence terms;
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(d)

(iii) if you have a subscription version, have the Software reactivated (on payment of Reckon’s renewal fee
and verification of your licence details) if you wish to renew the subscription;

(iv) have the Software reactivated by Reckon if you wish to re-install the Software (for example, if you would
like to install the Software on a new computer or if you have a hard drive failure and need to reload your
Software); and

(v) provide to Reckon the details of your installation key code and product key for the Software as part of
the reactivation process.

You agree to activate or reactivate the Software within a reasonable time or within such time as the Software
prompts you to do so.

Key codes: Each copy of the Software is provided with a unique installation key code (“IKC”) (which may
appear on the packaging or the cover of the media on which the Software is contained). This IKC is for your
exclusive use only in accordance with the terms of this Licence. You should keep the IKC safe. As per clause
4(a)(v), you will be required to provide your installation key code to Reckon when you reactivate your Software.

Manner of verification: You must verify your licence details in the manner required by Reckon from time to
time (which may include email or on-line registration via the Internet). The Software may prompt you as to the
required manner of verification.

Charges for reactivation: Reckon will not charge you to activate the Software initially or to reactivate your
Software when you verify your licence details or renew a subscription, unless you have lost your installation
or licence key code. You need both your installation code and your licence key to be able to reactivate the
Software. Reckon may charge you a fee for technical support to reissue a licence key code. Reckon may also
charge a fee for technical support if you need to reactivate the Software in other circumstances (for example,
if you need to reinstall the Software because you have a new computer or need to reload the Software due to
a hard drive failure). For the current fees go to www.reckon.com. If you have lost your installation key code,
Reckon will not replace that code, and you may be required to purchase new software.
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Consequences of non-renewal and failure to verify details: This Software is provided to you on the
understanding and acknowledgment that it may contain technology which deactivates and disables the
Software if a subscription is not renewed or in the case of a full licence version, you have not verified your
licence details when periodically prompted to do so by Reckon or by the Software. If the Software is not
reactivated within the required period, the Software may continue to operate but with impaired functionality
or you may not be able to access the Software at all (including printing out or viewing any of your data or
records).

Statutory declaration: In certain circumstances, before permitting a re-activation, Reckon may require you to
provide it with a Statutory Declaration stating the reasons for re-activation in a form required by Reckon.

Older versions: Reckon has a sunset policy (covered in more detail in clause 6(a)) which means that
technical support is not available for certain older versions of the Software. If technical support is not
available for your version, you will not be able to reactivate or reinstall your Software if you do not have your
registration key code. Reckon will not be obliged to provide you with a replacement key code and in those
circumstances you will need to purchase a new version or Upgrade in order to continue using the Software.
Please go to www.reckon.com to see the sunset policy.

DATA COLLECTION AND PRIVACY

You acknowledge and agree that Reckon collects information from you when registering, activating and
validating the Software. Additional information may also be collected in relation to your use of the Software.
Reckon handles personal information in accordance with the Privacy Act 1988 (Cth) and the applicable
Privacy Principles. For details on how we collect, use, disclose and store your personal information and how
you can contact us if you want to access or correct personal information please refer to Reckon’s Privacy
Policy on our website www.reckon.com.

By activating and using the Software, including technical support:

157



(i) you agree to allow Reckon to use and disclose any personal information provided to Reckon in
connection with this Licence in accordance with Reckon’s then current privacy policy displayed on
Reckon’s website; and

(if) you acknowledge and agree that you are solely responsible and liable for any personal information you
collect, use or store using the Software.

6. TECHNICAL SUPPORT

(a) Period when technical support is available: Reckon will provide technical support for the Software only (and for
the avoidance of doubt this does not include support for third party hardware or software, which remains the
responsibility of the relevant third party), during the following periods:

(i) in the case of a subscription version of the Software, during the period for which you have paid the
relevant subscription fees (unless further releases of the Software in question are discontinued); and

(ii) in the case of a full version of the Software, there is a ‘sunset period’ during which technical support
may not be available for that version. The sunset period for a version will commence on the earlier of:
(A) 2 years after the date on which you first installed the version on our computer; or
(B) the date Reckon releases the second successive Upgrade to that version.

For further explanation of Reckon’s sunset policy please go to http://www.reckon.com.

(b) What is included as part of technical support: Reckon will provide technical support in accordance with its
then current technical support policy, which may include:

(i) as contemplated by clause 4, the technical support required to reactivate the Software or to issue
a replacement registration key code (for example, when you verify your licence details, renew a
subscription or if you need to reinstall the Software);

(ii)y provision of telephone help desk support services;
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(iii) access to technical information about the software contained on Reckon’s website; and
(iv) the ability for you to download Updates, but it does not include provision of Upgrades of the Software.

For further explanation of Reckon’s technical support policy please go to http://www.reckon.com.

Fees: Clause 4(d) sets out the circumstances when you will (and when you will not) be required to pay
charges for the technical support to reactivate your Software (including when you wish to reinstall the
Software) or for Reckon to issue a replacement registration key code.

For all other technical support, Reckon may charge you a fee in accordance with its then current technical
support policy.

(@)

(b)

. ONLINE SERVICES

Interaction with Online Services: The Software may contain access to, or features that interface with, third
party online services (“Third Party Online Services”). Examples of Third Party Online Services that may be
applicable to the Software are ASIC, EFTPOS, SBR-enabled services, an online share price download facility,
bank data feeds, statement download facility, bill and other payment services, a superannuation choice
facility, payroll services and a debt recovery facility, technology, hardware or application, which may or may
not be provided at an additional charge on a subscription basis measured for one year from the date of
registration.

Terms for Third Party Online Services: Certain Third Party Online Services are not available for all versions

of the Software. For example, in the case of bank statement download services, not all banks provide
services that connect to the Software. Third Party Online Services are only available for 12-month periods
for subscription versions and 24-month periods for full versions. In the case of a full version, access to Third
Party Online Services in the second 12-month period may be subject to payment of the applicable charges.
In order to renew access to Third Party Online Services at the end of the 24-month period in the case of a
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full version, you will be required to have purchased or upgraded to the latest version of the Software. In the
case of a subscription version, you must have renewed your subscription. Internet access is required for all
Third Party Online Services. Charges may apply for the use of Third Party Online Services (in addition to the
cost of Internet access levied by your ISP). Where Third Party Online Services are available, separate terms
and conditions with the provider of the Third Party Online Services may apply. In some cases Reckon may be
the provider. You should check with the relevant third party provider as to the terms and conditions of use.
You are responsible for all information and authorisations provided to access and use any such Third Party
Online Services and for any data, form or other output relying on the use of the Third Party Online Services
and/or the Services. Except as may be required by the Consumer Guarantees, access to Third Party Online
Services may be withdrawn by Reckon at any time. Reckon will not be liable for the withdrawal of access

to any Third Party Online Services. Where access is to be withdrawn, Reckon may choose to notify you in
advance provided that you have supplied Reckon with a valid and up to date email address.

In some cases you may download other third party applications, for example Google Desktop supplied by
Google Inc. In such cases your agreement to be bound by the terms of this Licence will also bind you to the
terms of use or other similar agreements required by such third parties for use of their products.

. LIMITED WARRANTY

This clause 8 is subject to the consumer guarantees regime as set out in Schedule 2 to the Competition and
Consumer Act 2010 (Cth) (also referred to as the Australian Consumer Law), and the Consumer Guarantees Act
1993 (NZ), as amended from time to time, or other similar legislation of a state or territory of Australia or NZ
respectively (“Consumer Guarantees”).

In Australia, our goods come with guarantees that cannot be excluded under the Australian Consumer Law. You
are entitled to a replacement or refund for a major failure and compensation for any other reasonably foreseeable
loss or damage. You are also entitled to have the goods repaired or replaced if the goods fail to be of acceptable
quality and the failure does not amount to a major failure. In New Zealand, these guarantees cannot be modified
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nor excluded by any contract, except in those circumstances contemplated by section 43(2) of the New Zealand
Consumer Guarantees Act.

@)

(b)

(c)

(d)

Software provided on an ‘as is’ basis: Except as required by the Consumer Guarantees, Reckon provides
the Software to you on an “as is” basis and without any representations by Reckon or any of its authorised
distributors regarding the use, performance or results of the use, of the Software.

Defects in media: In addition to any rights and remedies you have under the Consumer Guarantees, Reckon
warrants that the media on which the Software is recorded is free from defects in manufacture for a period
of 90 days from the date of delivery (for on-line purchases) or 90 days from the date of purchase (for in-store
purchases). During this period, subject to clause 8(c), Reckon will replace any defective media on which the
Software was supplied and any Software on that media, free of charge, unless you caused damage to the
media due to poor handling.

To make a claim under clause 8(b), you must:
(i) email customerservice@reckon.com with the subject line ‘warranty claim’, and include the following:

(A) in the body of the email, provide the IKC, detail the fault and whether a workaround has been pro-
vided by a member of Reckon’s support team; and

(B) provide a copy of the receipt or proof of purchase and payment.

Once Reckon receives the information, Reckon will provide a preliminary assessment of the claim and
contact you to advise. Software assessed on a preliminary basis to be defective by Reckon will be replaced
by Reckon and sent to you at Reckon’s cost.

No guarantee that Software will be error free or that its use will be uninterrupted: While Reckon has
endeavoured to make sure that the Software works substantially as per the specifications published by
Reckon from time to time, except as required by the Consumer Guarantees, Reckon does not guarantee that
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the Software will work on all computer hardware platforms or configurations and makes no warranty that the
Software will be error free or that its use will be uninterrupted.

Internet access, telecommunications networks, firewalls and security: Except as required by the Consumer
Guarantees, Reckon does not guarantee connections to its online activation server as these may be
dependent upon third party networks and security measures over which Reckon has no control.

9. LIABILITY

(@)

(b)

(€

Certain rights cannot be excluded: Certain laws, including the Consumer Guarantees, may imply certain
guarantees, conditions and warranties into this Licence or impose certain guarantees, conditions and
warranties by law and give you certain rights and remedies that cannot be excluded or modified. This clause
9 and the limited warranties provided in clause 8, do not exclude or modify any of those rights if to do so
would contravene that law or make any part of this Licence void.

Exclusion of warranties: Except as required by the Consumer Guarantees, Reckon excludes all guarantees,
conditions, warranties and rights that may be implied into this Licence or imposed by law. If guarantees,
conditions, warranties or other rights for your benefit are implied in this Licence or otherwise conferred by
law and it is not lawful to exclude, restrict or modify them, then those guarantees, conditions, warranties and
other rights will (but only to the extent required by law) apply to this Licence.

Limitation of implied terms: In relation to goods or services not ordinarily acquired for personal, domestic or
household use, Reckon’s (and its distributors’) liability for breach of any guarantees, implied conditions or
warranties that cannot be excluded is limited, to the extent permitted by law and at the option of Reckon,
to repair the goods, or the cost of repairing the goods, to replacing or re-supplying the goods or services

or their equivalent again or the payment of the cost of having the goods or services or their equivalent
replaced or supplied again. You acknowledge that this clause, and any reliance on it by Reckon, is fair and
reasonable.
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(d) General exclusion and limitation: Other than as set out in clauses 9(b) and 9(c), and as required by the

(e)

(f)

Consumer Guarantees:

(i) Reckon (and its authorised distributors) will not be liable to you or any other person for any direct

or indirect loss, damages, liability, costs or expenses suffered by you or any other person relating to

the performance or non-performance of the Software or any breach of this Licence or the supply of

the Software or in connection with, but not limited to, the Third Party Online Services, delays, non-
performance, failure to perform, processing errors use of tax tables, use of third party hardware (for
example but not limited to Postec services) or provision of technical support (whether by telephone

or remote access or other means), nor will the liability of Reckon include or extend to any special or
consequential loss or damage suffered by you, except where required by the Consumer Guarantees; and

(i) Reckon’s maximum liability for damages arising in connection with this Licence or the supply of the
Software is limited to the amount paid by you for the Software.

Your liability to Reckon: You agree that Reckon (and its authorised distributors) will not be liable, other than
as required by the Consumer Guarantees or as expressly set out in this Licence, and that you will indemnify
the Reckon (and its authorised distributors) from any liability, loss, damage, costs or expenses which you
may suffer or incur as a result of your use of the Software (including any claims made against you by third
parties).

Use of Software is not provision of professional advice: The information contained in the Software may
contain features designed to assist you in complying with the requirements of the relevant legislation at

the time of the release of the Software, which includes for example, but not limited to superannuation
guarantee requirements, tax tables, rates for contributions or deductions calculated using the Software.
These compliance requirements may change from time to time. You agree it is your obligation to ensure the
details, calculations, reports and any other data or documents produced using the Software, are correct and
compliant when created or used by you. Legal, accounting or other relevant professional advice should be
obtained before taking any action in reliance on the Software or what is produced by you using the Software.
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The Software is also not financial product advice. You acknowledge that Reckon is not engaged in rendering
legal, accounting or other professional services and nothing in the Software constitutes taxation, financial,
wealth management, superannuation or other professional advice in relation to these matters. The help
contained in the Software is not a substitute for obtaining the appropriate independent professional advice. If
legal advice or other expert assistance is required, you should seek the service of the appropriate competent
professional.

Reckon has no responsibility for recommendations: Except as required by the Consumer Guarantees, Reckon,
its employees, agents, contractors and the authors disclaim any and all liability and responsibility to any
person, whether a user of this Software or not, in respect of anything (including, without limitation, any error
in or omission from this Software) and of the consequences of any actions taken or omitted to be taken in
reliance, whether wholly or partially, upon all or any part of the content, recommendations or help contained
in this Software.

Corruption of Data and on-line access: Except as required by the Consumer Guarantees, Reckon and its
authorised distributors disclaim all liability for any corruption of data, inability to access data, loss of data,
breach of privacy, or downtime as a result of or arising from the use of any online link available between the
Software and another server including without limitation in connection with Online Services.

Third Party Online services: Except as required by the Consumer Guarantees, Reckon makes no warranty or
representation in connection with the Third Party Online Services, or third party hardware (for example, but
not limited to bank data feeds, Postec services) the responsibility for which rests with the relevant provider of
such Third Party Online Services or such hardware.

Third Party On-line Service Providers (“TPS Providers”): Except as required by the Consumer Guarantees,
neither Reckon or any TPS Providers, including but not limited to any bank, will be responsible for any data
submitted, entered or created using the Services or any Third Party Services (for example, including but
not limited to bank data feeds), delays, non-performance, failure to perform, processing errors or any other
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matter or thing which may be required from any TPS Providers, such as an authority or approval, or any
agreement with Reckon or any TPS Providers, as the case may be. You are responsible for the accuracy of
all data entered; all output created by you relying on the data entered; and where relevant, that any data

or document lodged is accurate, timely and is compliant with all relevant laws and regulations, including
keeping the required documentation and records needed to be kept to meet regulatory requirements in
relation to the information or material lodged and any other data retention or compliance requirements.
Nor will the liability of Reckon, or any TPS Providers, including but not limited to any bank (whether jointly,
severally or jointly and severally) include or extend to any special or consequential loss or damage suffered

by you.

10. TERM AND TERMINATION OF LICENCE

(a) Licence Term: Unless this Licence is terminated earlier in accordance with its terms, your right to use the
Software in accordance with this Licence continues:

(i)

in the case of a subscription version of the Software, for an initial period of 12 months from the date of
registration of the Software. This Licence will automatically renew for a further 12 month period upon
the payment of Reckon’s annual subscription fee. If the annual subscription fee is not paid on or before
the termination of the current 12 month period, this Licence will automatically terminate; and

in the full version of the Software, indefinitely, however:

you may be required to periodically verify your licence details and have the Software reactivated as per clause 3 in order to keep
using the Software; and

if you need to reinstall the Software, you will need a copy of your original DVD (or other media on which the Software was provided)
and the installation key code. If you do not have the DVD, you will need to purchase or upgrade to a new full version and pay for
the postage associated with sending the DVD to you. Clauses 4(d) and 4(g) outline when Reckon may charge you a fee for the
provision of a replacement key code and, more importantly, when a replacement key code will not be provided by Reckon due to

the operation of Reckon’s sunset policy.
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(b) Termination by Reckon for breach: Reckon may terminate this Licence if you are in breach of its terms or as
otherwise set out in this Licence.

(c) Survival: Clauses 2, 7, 8, 9 and this clause 10 will survive the termination of this Licence. Termination of
this Licence will not prejudice any right which Reckon may have, or but for the termination may have had,
against you for a breach of this Licence.

(d) Things you must do on termination: Upon the termination of this Licence, you or your representative must
promptly uninstall the Software from your computer, destroy the DVD, User Guide and related materials and
any copies of them in your possession or control or return or dispose of them in the manner directed by
Reckon. Upon written request from Reckon you agree to provide a Statutory Declaration to Reckon that you
have complied with your obligations under this clause 10(d).

11. SUBSCRIPTION TERMS

If you have purchased a subscription version of the Software, this additional clause 11 will apply.

(a) Entitlement to Upgrades and Updates: During the period for which you have paid subscription fees you will
receive, included in the cost of the subscription, all Upgrades and/or Updates of the Software, via Internet
download.

(b) No extension of Licence term: Your right and entitlement to use the Software, as enhanced by any
Upgrades and/or Updates, concludes at the end of the term of the Licence (subject to payment of an
annual subscription fee) and is not linked to the dates of release, registration or provision by Reckon of any
Upgrades and/or Updates.

(c) This Licence prevails: If you have purchased this Software as an Upgrade to an earlier version of the Software,
this Licence shall supersede any previous licence agreement.
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(d)

(e)

(f)

&)

(h)

License Agreement

Not all Upgrades included: Your subscription to the Software and any Upgrades and/or Updates under

this Licence does not grant you the right to receive special versions of the Software created for certain
customers or market segments, even though they may contain similar features or functions. Versions of
the Software which may from time to time be offered in retail or other channels in different configurations as
special promotions are not included as part of the subscription.

No obligation on Reckon to upgrade: Upgrades and/or Updates will be developed and released by Reckon in
its sole discretion, and Reckon does not warrant or represent that it will develop or release any Upgrades
and/or Updates during the term of the subscription period or Licence. Furthermore, Reckon does not
warrant that the Upgrades and/or Updates will be provided to you or made available within any specified
time period following the commercial release of such Upgrades and/or Updates.

When payment is due: If applicable to the Software licensed to you, you will be required to pay the monthly
subscription fee in advance on the first business day of each month. You authorise Reckon to direct debit
your monthly subscription fee from the bank account nominated by you.

Deactivation at end of subscription period: As per clause 4, the subscription version of the Software is
provided to you on the understanding and acknowledgment that it may contain technology which deactivates
and disables the software if your subscription is not renewed or you are found to be in breach of this licence
agreement. If the Software is not renewed by the end of the required period, the Software may continue

to operate but with impaired functionality or you may not be able to access the Software at all (including
printing out or viewing any of your data or records).

You need a full version if you don’t renew: If you elect not to renew your subscription, the Software does not
allow you to upgrade to a non-subscription version of the Software by way of the purchase of an Upgrade
pack. In such circumstances, you are only able to upgrade to a later non-subscription version of the
Software by purchasing a full (non-upgrade) version of the Software.
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(i)

Early termination: If you wish to terminate your subscription early, you must do so by giving Reckon no less than one
calendar month notice to that effect. Depending on the type of software you have subscribed to and the type of
subscription you are signed up for, you may be required to pay a cancellation fee. See http://www.reckon.com for a
schedule of fees. Reckon will direct debit your account, and you agree to pay, the applicable cancellation fee.

12. TRIAL LICENCE

If you have been provided with a Trial Version of the Software, this clause 12 sets out the terms that will apply to your use of
the Trial Version.

(@)

(b)

()
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Licence: Your licence to use the Trial Version:

(i) permits you to evaluate the Software’s functionality and suitability for your requirements;

(ii) is for the number of users set out in the material accompanying your copy of the Trial Version;
(iii) is subject to the general restrictions in clause 2(e) and the limited warranty in clause 8;

(iv) is for one month (Trial Period) commencing on the first day of installation and activation of the Software or such
other period as expressly agreed in writing by Reckon; and

(v) does not integrate with Accounts.

Duration: You acknowledge that your licence to use the Trial Version will only apply for the Trial Period. At the end of the
Trial Period:

(i) you must not and will not be able to continue to access the Trial Version, including any data that you have entered
into the Trial Version; and

(ii) if you wish to use the Software you must purchase a full version or subscription version of the Software.

Entitlements: You:



(d)

License Agreement

(i) are not entitled to Upgrades or Updates (or any other software other than the Trial Version); and

(ify may be required to pay for any technical support that you may require in relation to the Trial Version in
accordance with Reckon'’s then current charges.

Liability: You acknowledge that subject to clauses 8(b) and 8(c), and other than as required by the Consumer
Guarantees, Reckon excludes all liability to you for any loss, damage, liability, costs or expenses suffered by
you relating to the performance or non-performance of the Trial Version or any breach of this clause 12.

13. ACADEMIC EDITION:

(@)

if you are using an ACADEMIC Edition, your Software may have limited licence rights as well as limited
functionality, including;:

(i) a limit on the number of transactions that can be entered;
(if)y a limit on the number of company files that can be opened; and

(iii) a limit on the number of Accounts features and services available.

Your Software may be deactivated at the end of three years from date of installation and this may prevent
access to the Software and data unless an appropriate upgrade is purchased.

There is no support available for an Academic Edition. Support must be directed to your educational
institution.

Except as required by the Consumer Guarantees, Reckon does not warrant that any information in the
Software is up to date, for example functionality required for certain lessons involving tax tables or payroll
tax, and it is your sole responsibility to check with your educational institution whether any information is up
to date.
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14. GENERAL

(@)

(b)
()

(d)

(e)

(f)

(&)
(h)

Some defined terms: In this Licence:

Trial Version means Software that has been provided to you on a temporary basis in order to carry out a trial of that
Software to determine whether you wish to use the Software on an ongoing basis.

Academic Version means Software that is licensed to you as part of your educational institutions arrangement with
Reckon or Software that you have purchased that Reckon has determined is an Academic Version.

Upgrade means a new version of the Software which contains additional functionality or other enhancements. Reckon
will determine whether a new version constitutes an Upgrade or an Update.

Update means a new version of the Software which contains minor enhancements.
Accounts Enterprise: The current version of Accounts Desktop software or Enterprise.

Applicable law: This Licence is governed by the laws of the State of New South Wales, Australia and by agreeing to be
bound by the terms of this Agreement you irrevocably and unconditionally submit to the jurisdiction of the courts of
that State.

Consumer Guarantees: Are the consumer guarantees regime as set out in Schedule 2 to the Competition and
Consumer Act 2010 (Cth) (also referred to as the Australian Consumer Law), or the Consumer Guarantees Act 1993
(NZ), as amended from time to time, or other similar legislation of a state or territory of Australia or NZ respectively.

Entire Agreement: This Licence contains the entire agreement between Reckon and you in relation to its subject matter
and supersedes any prior agreements and understandings, whether written or oral.

Evaluation Fee: The fee set out on the pricing page of the Website at the relevant time to obtain an Evaluation Licence
to use the Services on trial.

Headings: Clause headings are for ease of reference only and do not affect the meaning of this Licence.

Privacy Laws: Privacy Act 1988 (Cth) and the Australian Privacy Principles (“the Privacy Principles”), as amended from
time to time.



(i)  Third Party Applications and Technology: When using the Services, you may access third party applications and
technology. The terms of the third party’s Licence will apply to your use of all such third party applications and
technology.

(j) Variation: To the extent permitted by law, Reckon may vary any of the terms and conditions of this Licence upon
providing you with thirty (30) days notice in writing and a copy of the replacement terms and conditions. No new terms
will come into force until the commencement of your renewed Subscription Period. Reckon will display any new terms
and conditions on the Website and you should check the website regularly.

(k)  Waiver: Any failure to enforce any rights under this Licence by Reckon is not to be taken as a waiver of those rights.

(I) Reckon’s Contact details:

business address: Level 2, 100 Pacific Highway, North Sydney, NSW 2060

postal address: Reckon Limited, Locked Bag 7522, McMahons Point, NSW 2060
contact number: 1300 784 253

contact email: customerservice@reckon.com

Website: www.reckon.com

Reckon, Reckon logo, Reckon Accounts and R Logos are trademarks of Reckon Limited.
Software © 2019, Intuit Inc. All rights reserved.



Your important reference numbers

Customer ID:

Customer PIN:

Installation Key Code:

Installation User

Product Key

Licence Key

PC 1

Example Reception

10030-59821-00858-381

36934-42890-33878-21990

PC 1

PC 2

PC3

PC 4

PC5

You will need these numbers for re-registration purposes. Please have these numbers on hand when contacting us.

DVD Location. My original DVD is safely stored:

(describe location or contact person)




Accounts Business Range Keyboard Shortcuts

General Key Insert line in detail area Ctrl + Ins New invoice, bill, cheque or listitem  Ctrl + N
To start Reckon Accounts withouta  Ctrl Cut selected characters Ctrl + X in context
company file (while Copy selected characters Ctrl+C Paste copied transaction in register  Ctrl + V
= ; - Ziemng) Paste cut or copied characters Ctrl +V Print Ctrl + P
o suppress all open windows, i
first dzﬁble click tFr)le Reckon (while Increase cheque or other form + (plus key) gu!c::;oom non rteport m st St +Q
Accounts (chart) icon, then... opening) number by one itel:':fn: eport on transaction or fis r
Display product information about F2 Decrease cheque or other form - (minus key) Open split transaction window in Cirl+S
your Reckon Accounts version number by one register
Close active window Esc or Ctrl+F4 Undo changes made in field Ctrl+ 2 Show List Ctrl + L
Record (when black border is ! Use list item Ctrl + U
around OK, Save and Close, Save Help Window Key —
- - Open transaction journal Ctrl +Y
and New, or Record) Display Help in context F1 — -
- Delete cheque, invoice, transaction, Ctrl + D
Record (always) Ctrl + < Go to next Help topic Tab or item from list
Go to previous Help topic Shift + Tab
Dates Key Display selected topic i Moving around a window Key
Next day + (plus key) Next field Tab
Previous day - (minus key) Activity Key Previous field Shift + Tab
Today T Open account list Ctrl +A Report column to the right Right arrow
First day of the Week W Write new cheque Ctrl + W Report column to the left Left arrow
Last day of the weeK K Copy cheque transaction in register  Ctrl + O Beginning of current field Home
First day of the Month M Open Customer Centre (Customers  Ctrl +J End of current field End
Last day of the montH H Joblis) Line below in detail area or on Down arrow
First day of the Year Y Edit lists of registers Ctrl+E report 1)
Last day of the yeaR R QuickFill and Recall (type first few abc Tab Line above in detail area or on Up arrow (1)
Date calendar Alt + down letters of name and press Tab, report
arrow (4) name fills in) Down one screen Page Down
— Find transaction Ctrl + F Up one screen Page Up
E:Itlng , e —" gely+ = Go to register of transfer account Ctrl + G First item on list or previous month  Ctrl + Page
Fdl ransaction selected n register U1 History of A/R or A/P transaction _ Ctrl + H in register Up
PR Last item on list or next month in Ctrl + Page
Delete character to right of Del Create invoice Ctri+ 1 register Down ¢
insertion point Open list (for current drop-down Ctrl + L Next word in field Ctrl + —
Delete character to left of Backspace menu) Previous word in field Ctrl + «
insertion point (<) Memorise transaction or report Ctrl + M Close active window Esc or Ctrl
Delete line from detail area Ctrl + Del Open memorised transaction list Ctrl+T +F4
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